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Live Services Management

NetWitness Live is the gateway to a rich environment that offers access to feeds, tools, and other
resources.

NetWitness Live

Live is the component of NetWitness that manages communication and synchronization between
NetWitness services and a library of Live content available to NetWitness customers. Live provides a
simple interface for browsing, selecting, and deploying content from the NetWitness Live Content
Management System to NetWitness services and software. In addition to managing feeds from the CMS
Library, Live allows users to deploy custom feeds and packages.

Note: Any customer with valid maintenance can access NetWitness Live.

Note: If you are logged into an Analyst UI, you can only view but cannot enable, disable, edit, or
configure NetWitness Live.

The content management system (CMS) library (known as Live) is a valuable source of the latest
internet security resources for NetWitness customers. It provides a view into the collective intelligence
and analytical skills of the worldwide security community to ensure that users have the most current
visibility into attack vectors.

Live gathers the best advanced threat intelligence and content in the global security community - the
ideas, research, ongoing tracking, and analysis - and brings it directly into the user’s security operations
center to definitively classify computers associated with botnets, malware, and other malicious exploits.
Live aggregates, consolidates, and illuminates only the most pertinent information relevant to an
organization on a real-time basis.

NetWitness Feedback and Data Sharing

Live Feedback is intended to help improve NetWitness. Once you set up and configure a Live account,
usage data is shared with RSA.

For more details, see NetWitness Feedback and Data Sharing.

For Debian Linux and NetWitness Endpoint Users

If you are upgrading to NetWitness 12.5 and you are using NetWitness Endpoint and also have any
Debian Linux endpoint systems, NetWitness recommends that you go to Live and download the
following application rules:

e autorun debian package mismatch
 autorun file path not part of debian package
¢ debian package hash mismatch in important system directory

e debian package hash mismatch
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* file path not part of debian package in important system directory
« file path not part of debian package
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Deploy Content

This section explains the different ways available to deploy content:

e Deploy Content using Live Content Ul

* Centrally Deploy Content using Policy Ul

Deploy Content
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Create Live Account

Note: The NetWitness Live Registration Portal now has a new user interface and supports email
verification.

You must create a Live account using the NetWitness Live Registration Portal
(https://live.netwitness.com/registration/) on the Live server. Live Account is required to access all Live
services including CMS. The CMS Library provides access to all NetWitness content in one place where
you can view, search, deploy, and subscribe to NetWitness content.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

Make sure the following are available to set up a NetWitness Live account:

e Active internet connection to access the portal.
e A valid and registered NetWitness License Server on the Flexera Server, before you can register for a

Q
Live account. You can view the License ID on the (Admin) > System > Info panel.

Note: If the License Server is not set up, contact NetWitness Customer Support.

To create a Live Account:
1. Access the NetWitness Live Registration Portal using the URL: https://live.netwitness.com/
The NetWitness Live log in page is displayed.

Deploy Content 9
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2.

NETWITNESS

Sign in with your username and password

Username *

Password *

SIGN IN SIGN UP FORLIVE

Click Sign Up For Live.

The End User License Agreement page is displayed.
Read the Terms and Conditions carefully and click Accept.

Welcome to RSA Live Registration Portal

Thank you for using RSA NetWitness.
Please sign up here for your RSA Live account to access your subscription content.

End User License Agreement

THIS SOFTWARE CONTAINS COMPUTER PROGRAMS AND OTHER PROPRIETARY
MATERIAL AND INFORMATION, THE USE OF WHICH IS SUBJECT TO AND EXPRESSLY
CONDITIONED UPON ACCEPTANCE OF THIS END USER LICENSE AGREEMENT (THE
“AGREEMENT").

THIS AGREEMENT IS A LEGALLY BINDING DOCUMENT BETWEEN YOU (MEANING
THE INDIVIDUAL PERSON OR THE ENTITY THAT THE INDIVIDUAL REPRESENTS
THAT HAS OBTAINED THE SOFTWARE AND HARDWARE FOR ITS INTERNAL
PRODUCTIVE USE AND NOT FOR OUTRIGHT RESALE) (THE “CUSTOMER”) AND
NETWITNESS (WHICH MEANS (1) RSA SECURITY LLC, IF CUSTOMER IS LOCATED IN
THE UNITED STATES, MEXICO OR SOUTH AMERICA; (Il) THE LOCAL NETWITNESS
SALES AFFILIATE, IF CUSTOMER IS LOCATED OUTSIDE THE UNITED STATES, MEXICO
OR SOUTH AMERICA AND IN A COUNTRY IN WHICH NETWITNESS HAS A LOCAL
SALES AFFILIATE; OR (lll) RSA SECURITY & RISK IRELAND LIMITED OR OTHER
AUTHORIZED NETWITNESS ENTITY AS IDENTIFIED ON THE NETWITNESS QUOTE
OR OTHER NETWITNESS ORDERING DOCUMENT, IF CUSTOMER IS LOCATED
OUTSIDE THE UNITED STATES, MEXICO OR SOUTH AMERICA AND IN A COUNTRY IN
WHICH NETWITNESS DOES NOT HAVE A LOCAL SALES AFFILIATE). Unless
NetWitness agrees otherwise in writing, this Agreement governs Customer's use of the
Software and Hardware, except to the extent all or any portion of the Software or
Hardware is: (a) the subject of a separate written agreement set forth in a quotation

ACCEPT

In the Sign Up for NetWitness Live Account page, enter all the fields:

¢ The First Name and Last Name of the user.

¢ The Company for which the Live Account is being created.

e The Email address you enter will be used to receive the verification code for your new Live

account and other notifications related to the Live account.

The License ID can be viewed on Kl (Admin) > System > Info panel.

10
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¢ The Username and Password for the Live Account.

NETWITNESS

Sign Up for Netwitness Live Account e

First Name

Last Name

Company

License ID

Username

Password

CREATE ACCOUNT

4. Click Create Account.
You will be directed to Confirm Sign up page.

b

Enter the Confirmation Code sent to your registered email address.

Click Confirm.
You can see the confirmation message for your NetWitness Live Account registration.

Note: You cannot create more than one Live account for the same License ID. For additional
license, contact NetWitness Customer Support.

&

Once the account is created, enter your credentials and click Sign In to access the NetWitness Live.

~

After you sign in, you can perform the following:

e Search and Download Content from NetWitness Live

e Share Telemetry Data to NetWitness

Deploy Content 11
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Reset the Password for Your NetWitness Live Account

If you want to reset the password for your NetWitness Live Account, do the following:
1. Access the NetWitness Live Registration Portal using the URL:

https://live.netwitness.com/

The NetWitness Live log in page is displayed.

NETWITNESS

Sign in with your username and password

Username *

Password *

SIGN IN SIGN UP FORLIVE

2. On the Sign Up page, click Forgot Password?.

3. Enter your Username and click Send Code.
A verification code will be sent to your registered email address.

4. Enter the Verification Code and New Password on the Reset Password page and click Submit.

12 Deploy Content
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Set Up Live Services on NetWitness Platform

To set up Live on NetWitness Platform, you configure the connection and synchronization between the

QA
CMS server and NetWitness. The user interface for this setup is the (Admin) > System > Live
Services Configuration panel.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

To configure the connection to the CMS Server:

a
1. Navigate to (Admin) > System > Live Services.

2. Click Sign In and enter your credentials in the Live Services Account dialog box.

Live Services Account

cms.netwitness.com

Port 443
551 ™
Username admin
Password S T T T

Test Connection

3. Click Test Connection to make sure your connection is working.

Deploy Content 13
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4. If the test is successful, click Apply. If not, contact NetWitness Customer Support for help
connecting to the Live server.

5. Configure the timing for synchronization of NetWitness Platform with updates from NetWitness
Live.

For more details, see the "Configure Live Services Settings" topic in the System Configuration Guide.

14 Deploy Content


https://community.netwitness.com/t5/support-information/how-to-contact-netwitness-support/ta-p/563897

Live Services Management Guide

Deploy Content using Live Content Ul

This topic explains the process of deploying the content using Live Content UL.

e Live Services Required Procedures

e Additional Procedures

e References

e Troubleshooting Live Services

Deploy Content 15
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Live Services Required Procedures

The following workflow describes the basic setup into four steps, which you perform individually.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

Optional
Search/Download .( P )
Live Content Configure Feedback
& Data Sharing
Create Live Account Create a Live Account on the NetWitness Live Registration portal
URL: https://live.netwitness.com/registration/.
Set Up Live Services on Set Up Live Services on NetWitness Platform by configuring a
NetWitness Platform connection with the CMS server.
Find and Deploy Live Search and browse for resources in the Live Search view, and then,
Resources deploy the selected resources.
Manage Live Resources Procedures for administrators to search for, subscribe to, and deploy

resources from Live.

Search and Download Content  Search and browse for content in the NetWitness Live, and then,
from NetWitness Live download the selected content.

NetWitness Feedback and Data  Describes the feedback and data sharing features provided in
Sharing NetWitness, from Live Services. Participation is optional, but can
help to provide useful threat intelligence for the community.

16 Deploy Content
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Find and Deploy Live Resources

Administrators can search for resources in the Live Search view, which is also the same as browsing the
Live CMS for resources using the Search Criteria panel of the Live Search View.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

Find Resources in Live

IMPORTANT: ESA Rules cannot be deployed manually via Live Services. By default, all the ESA
rules are available in the ESA Rule library if Live Service is configured.

To find resources:

1. Navigate to (Configure) > Live Content.

2. In the Search Criteria panel, specify search criteria. Enter any or all of these: keyword, category,
type of resource, medium, meta keys, meta values, date resource was created, and date resource was

Deploy Content 17
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modified.
3. Click Search.
The Matching Resources panel displays detailed results.

NETWITNESS

CUSTOM FEEDS NCIDENT RULES NCIDENT NOTIFICATIONS MORE v

Search Criteria Matching Resources
Keywords Show Results | 3 Package
=o' RSA Malware PE Artifacts
Category Malware Rules 2018-05-04 11:11 PM 0.2 size 74.5 KB no
CIFEATURED Yara I0Cs which statically analyze Windows PE file artifacts for signs of malware.
» CJTHREAT
» CIIDENTITY ==y RSA Malware PE Packers
Malware Rules 2013-11-21 9:07 PM 0.1 93.97 KB no

» ASSURANCE
B Yara I0Cs which statically analyze Windows PE files to identify Common Packers

» [ OPERATIONS
[JsPecTRUM =¢' RSA Malware PDF Artifacts
[ MALWARE ANALYSIS Malware Rules 2013-11-21 9:07 PM 0.1 5878 no

Yara 10Cs which statically analyze PDF file artifacts for signs of malware
Resource Types

Malware Rules @  Log Collector @ v 4y McKesson HPF Log Collector Configuration
Log Collector 2017-09-13 5:09 PM 0.2 1.42 KB no
Medium Log Collector configuration content for event source McKesson HPF
v @ event analysis, operations, log analysis
Required Meta Keys g, SAP ERP Central Comy r
4 Log Collector 2017-09-135:10 PM no

Log Collector configuration content for event source SAP ERP Central Component

i 191 Matching Resources

4. (Optional) To further narrow the results In the Matching Resources panel, click on a tag, meta key,
medium or resource meta value in a result.

18 Deploy Content
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Deploy Resources in Live

In NetWitness, you can deploy selected resources manually, using the Deployment Wizard, or you can
subscribe to a group of resources.

e When you have results from browsing resources in NetWitness Live, you can deploy resources
manually to a service or a service group without subscribing to the resources. To deploy resources,
select one or more from the list.

* Deploying resources manually deploys to services without taking advantage of the powerful resource
management capabilities of NetWitness. If you want to receive notification and updates for updated
resources and be able to easily remove resources from a service, you must subscribe to resources in
the Live Search view and deploy them in the Live Configure View.

» If you have previously created and saved a resource package, you can deploy the package to services.
Please refer to Resource Package Deployment Wizard for instructions on how to create a package.

Caution: For NetWitness latest version, there is a new Content bundle for Endpoint, which contains
approximately 400 application rules. Do not deploy this bundle (or the Endpoint application rules) onto
any Log Decoder that is running an earlier version of NetWitness. The rules are only useful for the
latest version, and would have major performance implications if deployed on Log Decoders that
cannot process them.

To deploy resources manually:

1. Goto (Configure) > Live Content.
2. Select a group of resources, or a previously created resource package.

To select a resource or group of resources:

a. In the Live Search View, browse Live resources (for example, search for the Log Collector
resource Type).

b. In the Matching Resources panel, select Show Results > Grid.

c. Select the checkbox to the left of the resources that you want to deploy

Deploy Content 19
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NETWITNESS

Subscribed
Medium ¥ no Blacklisted File 20190410213 PM
v |¥ no Suspicious MSbuild UACB... 2022-10-27 8:14 AM

Required

Generated Meta Values

nclude Discontinued Resources

840 Matching Resources

In the Matching Resources toolbar, click

Deployment Wizard
Resources Services Review
Certain services are managed by Centralized Content Management(CCM), To manage service, click here

Total resources: 2

Resource Names Resource Type Dependency of

Blac] File

Application Rule

MShuild UAC Bypass Application Rule

Cancel

3. To select a resource package to deploy:

a.

CM). To manage cor

Updated Description

de:

A
2023.03.07 12:28PM

2022-11-227:14 AM

B Deploy

In the Live Search view - Matching Resources toolbar, select Package >Deploy .

The Package page of the Resource Package Deployment wizard is displayed.

20
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Resource Package Deployment

Package Resources Services Review Deploy

Resource Bundle Browse

Cancel Next

b. Click Browse and select a package from your network (for example resourceBundle-
FeedsParsersContent.zip).

c. Click Open.

At this point, whether you are deploying a package or a group of resources, the Deployment
Wizard opens, and the Resources page is displayed.

4. Click Next.
The Services page displayed has two tabs, Services and Groups, which provide a list of services and

4
service groups that are configured in the (Admin) > Services view. The columns are a subset of
the columns available in the Services view.

Note: The Live server is "smart" about deploying resources to Services. For example, it does not
deploy resources that have a Medium of packets to any Log Decoders. This means that only
applicable content resources are deployed to each Service.

5. Select the services on which you want to deploy the content. You can select any combination of
services and service groups.

¢ Use the Services tab to select individual services, list of services, and service groups that are
configured in the KZ4:M (Admin) > Services view.

¢ Use the Groups tab to select groups of services.
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Deployment Wizard

Resources Services Review Deploy
| ﬁ Name ~ Type
[l # UlEndpoint Other

Cancel Previous Next
6. Click Next.
The Review page is displayed.
Deployment Wizard
Resources Services Deploy
Service Service Type Resource Name Resource Type
124Endpoint-L... Log Decoder PostgreSQL Log Device
AWS Windows Log Device
AWS Route53 Resolver Log Device
Microsoft Azure Log Device
Kubernetes Log Device
AWS Log Device
AWS CloudTrail Log Device
Make sure that you have selected correct resources and the services on which you want to deploy
them.
7. Click Deploy.
The Deploy page is displayed. The Progress bar turns green when you have successfully deployed
the resources to the selected services.
22 Deploy Content
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Deployment Wizard

Resources Services Review

Live deployment task finished successfully

Service Name Resource Name Status Progress

Ul Endpoint Basic Rule Template 10f1 ‘ y

Close

If you try to deploy resources and services that are not compatible, NetWitness displays the Errors
and Retry buttons, which you can click to review the errors and re-attempt the deployment.

Package Resources Devices Review

Deployment in progress...
Device Name Resource Name Status Progress
Log Decoder4  Malware Domains 3of3 e ———

8. Click Close.
Next steps

After deploying parsers to Decoders and Log Decoders, you must enable parsers on the individual
services. For more information, see the Decoder and Log Decoder Configuration Guide.
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Manage Live Resources

With a connection to the CMS server, you can search for, subscribe to, and deploy resources from Live
in accordance with your subscription level. Once you have found resources, you deploy them to services

A
and service groups that have been configured in the the (Admin) > Services view.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

There are several workflows for deploying resources to services and managing those deployments. These
include:

* Subscribe and deploy resources

* Deploy a resource bundle

* Remove deployments of resources
* Download resources

* Set up data feeds

Manage Subscription and Deployment

The subscription and deployment workflow takes advantage of the resource management tools available
in Live. By subscribing to resources, you agree to receive updated resources in accordance with the

4
synchronization configured in the (Admin) > System > Live Services panel.

By adding subscribed resources to the deployments list, you configure NetWitness to automatically push
those resources to the selected services at the configured synchronization intervals. This method requires
some planning of service groups and services where resources are deployed. In addition:

* You can remove a resource from the deployments list in the Deployments Tab.

* You can unsubscribe from a resource in the Subscriptions Tab and the Live Resource View.
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To manage subscriptions and deployment:

Q
1. Inthe (Admin) > System > Live Services panel, specify an interval at which NetWitness
checks for updates to subscribed resources in Live and specify the email addresses of people to
receive an email listing subscribed resources that have been updated.

2. Inthe (Configure) > Live Content search view, search for and subscribe to Live resources.

3. Inthe (Configure) > Subscriptions > Deployments tab, select subscribed resources and add
them to the deployment list for services groups.

* to deploy the

=

4. (Optional) In the (Configure) > Subscriptions > Deployments tab, click *
resources listed in the Deployments tab immediately.

5. In the (Configure) > Subscriptions > Deployments tab, select deployed resources from a
Group, and remove them from services.

6. In the (Configure) > Subscriptions tab, unsubscribe from resources.

Remove a Deployed Resource

Once deployed to a service, Live resources remain on the service until removed. It is a good practice to
remove unused resources from services on which they are deployed.

To remove deployed resources:

1. Go to the Live Resource View .

2. Unsubscribe from a resource, and remove it from deployed services.

Deploy a Resource Bundle

To deploy a content package, use the Resource Package Deployment Wizard. You can deploy a content
package created in Live to one or more services. NetWitness accepts packages in .nwp files or .zip files.

Download Resources

To download resources to your local file system, use the Download button in the Live Resource view.

Set Up Data Feeds

In the Live > Feeds view, you can set up and maintain Custom and Identify feeds.
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Search and Download Content from NetWitness Live

Administrators can search for live content using the Search Content panel in the NetWitness Live, which

is similar to browsing the live CMS content in the (Configure) > Live Content page on the
NetWitness Platform.

Note: If Admin server is not connected to the Live Services, you can use the NetWitness Live to
search and download the required content.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

Prerequisites

e Ensure that you have created the Live account. For more information, see Create Live Account.

Quick Search for Content

You can now select and view the content based on the Sources available in the NetWitness Live. You
can select either NetWitness or Community from the Source drop-down list.

o NetWitness: Displays all the content provided by NetWitness.

¢ Community: Displays the content collected and retrieved from third party and open source
communities.

You can also quickly select and view the available content types under Content section.

Clicking = expands the Content section and displays the following options:
o New: Displays the content which is created in the last 21 days.

* Recently Updated: Displays the content which is created or updated in the last 21 days.
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FirstWatch Content

From 12.5 version or later, NetWitness introduces the FirstWatch Content section within the
NetWitness Live. This FirstWatch Content section serves as a centralized hub for accessing up-to-date
threat intelligence, including curated data and IOCs provided by NetWitness, to help you detect and
respond to threats. This threat intelligence is continually updated by NetWitness to ensure you have the
most current and actionable information for securing your network environment.

Clicking O expands the FirstWatch Content section and displays the following options:
e New: Displays the FirstWatch content which is created in the last 21 days.

e All: Displays all the FirstWatch content provided from NetWitness.

NETWITNESS

E Content

Content View New, recently updated and community content details here.

FirstWatch Content @ Community My Content

O New Showing All FirstWatch Content (2) Timezone : GMT+0530 Asia/Calcutta

All

Search Content CREATED & UPDATED & TYPE 4 MIN PLATFORM VERSION & DESCRIPTION *
20-Sep-202414...  20-Sep202414:..  Feed 11500 Content for testing-updated

20-Sep-2024 14.... 20-Sep-2024 14.... Feed 125.00 Content for testing-updated
<«

Advanced Search for Content

You can search for the specific content in the Search Content view. For more information, see Live
Search Content View.

To search the content:

1. Click H to expand the Search Content section.

2. In the Search Content, specify the search criteria. Enter any or all of these: FirstWatch, keyword,
type of resource, medium, risk, tag, platform versions, Mitre ATT&CK Tactics and Techniques, meta
keys, meta values, date when content was created, date when content was modified, and (optional)
discontinued content.
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Search Content

Show Only FirstWatch Content

KEYWORDS

RESOURCE TYPES

MEDIUMS

PLATFORM VERSIONS
12.5.0.0

ATT&CK TACTICS

ATT&CK TECHNIQUES

REQUIRED META KEYS

GENERATED META VALUES

CREATED DATE

MODIFIED DATE

Include Discontinued

Reset Filter

3. Click Search.
The matching results are displayed on the right panel.
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& Content

View New, recently updated and community content details here.

Community My Content

Showing Filtered Content (2363) Timezone : GMT+0530 Asia/Calcutta

CREATED 4 UPDATED # TYPE } MIN PLATFORM VERSION % DESCRIPTION 4

11-Sep-2020 01:23.... 10-Sep-2024 10:01.... Feed All Versions This feed contains Non-IP Address, text based indicators like Host...

11-Sep-2020 01:23.... 10-Sep-2024 10:01.... Feed All Versions This feed contains IP Address (IPv4 and IPv6) indicators that aress...

05-Feb-2024 14:53.... 23-Jul-2024 17:36.... Log Collector 12.3.0.0 Log Collector content for Logstash jdbc mssql auditing Pipeline

28-Apr-2023 08:44.... 23-Jul-2024 18:36.... Log Collector 12.4.0.0 Log Collector content for Logstash jdbc custom Pipeline

14-Apr-2023 15:58.... 23-Jul-2024 18:35:... Log Collector 12.2.0.0 Log Collector content for Logstash jdbc ibmdb2 auditing Pipeline

03-Apr-2023 11:51.... 30-Jul-2024 10:58.... Log Collector 12.3.0.0 Log Collector content for Logstash jdbc oracle 19c auditing Pipeline

14-Apr-2023 15:43.... 23-Jul-2024 17:34.... Log Collector 12.3.0.0 Log Collector content for Logstash jdbc oracle 12c auditing Pipeline

06-Mar-2023 15:01... 23-Jul-2024 17:34.... Log Collector 12.3.0.0 Log Collector content for Logstash jdbc oracle 11g auditing Pipeline

15-Mar-2023 12:36... 23-Jul-2024 17:34.... Log Collector 12.3.0.0 Log Collector content for Logstash jdbc oracle 18c auditing Pipeline

17-May-2023 15:0... 23-Jul-2024 14:01.... Log Collector 12.2.0.0 Log Collector content for Logstash jdbc ibmdb2 auditing Pipeline

17-May-2023 15:1... 23-Jul-2024 14:02.... Log Collector 12.3.0.0 Log Collector content for Logstash jdbc oracle 11g auditing Pipeline

The following is an example of FirstWatch Content Search results.

B Content

View New, recently updated and community content details here.
Community My Content

Showing All FirstWatch Content (2) Timezone : GMT+0530 Asia/Calcutta

CREATED 4 UPDATED 4 TYPE § MIN PLATFORM VERSION 4 DESCRIPTION §

FirstWatch 20-Sep-2024 14.... 20-Sep-2024 14.... Feed 11.5.0.0 Content for testing-updated

20-Sep-2024 14-... 20-Sep-2024 14-... 12.5.0.0 Content for testing-updated

€ ___________________________________________________________________________________________|

You can sort the content using the name, created, updated, type, or any of the column.

Note: Clicking Reset Filter removes the existing filters applied from the Search Content, and
displays all the available content on the right panel.

Download Content

You can download the content from the results displayed in the right panel by performing the following
steps:

Note:

- You cannot download a discontinued content.

- NetWitness provides no assurance related to the quality and accuracy of the content provided by the
third parties and open source communities.

Deploy Content 29



Live Services Management Guide

To download the content:

1. Click the name of the content that you want to download.

The Content Details dialog is displayed.

Content Details

NOTE: The following content s collected and derived from third-party, open sources. RSA
0 [NetWitness] at no times makes claims to the quality and/or efficacy above and beyond the
attestations of the authors of the content itself.

[Community] Malware, Malicious Code and APT Open Source YARA
Rules

TYPE

Malware Rules

UPDATED

16-Fet

DESCRIPTION

The following corpt

@ Large files may take longer time to start the download.

2. Click Download.

The content file is downloaded.

Manage Custom Content

NetWitness introduces the new My Content option, which allows users to upload, delete, and download
custom content from the Live Ul. Custom content refers to any content created by users using
NetWitness, such as Log Devices, Event Stream Analysis rules, parsers, feeds, etc. Using this capability,
users can facilitate the exchange of useful and relevant content among users and reduce the time and
effort required to publish content through content development teams. Users can choose from a range of

content options that suit their needs and use cases.
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NETWITNESS

Content i e ntly updated and community content detail

FirstWatch Content © Netwitness  Community
[ —— Showing My Content(43) Timezone : GMT+0530 Asia/Calcutta
2 Upload Content
NAME & CREATED * TYPE & INDUSTRY SECTOR 4 STATUS & MIN PLATFORM VERSION &

01-Aug-2024 14:01:04 Log Device Chemical Failed All Versions
30-Jul-2024 11:20:33 Event Stream AnalysisR..  Energy Rejected All Versions
30-Jul-2024 11:06:39 Event Stream AnalysisR...  Defense Industrial Base Published All Versions
30-Jul-2024 10:51:52 Event Stream AnalysisR...  Defense Industrial Base Published All Versions
29-Jul-2024 11:30:15 Event Stream AnalysisR..  Communications Rejected All Versions
29-Jul-2024 10:38:39 Event Stream AnalysisR...  Dams Rejected All Versions
29-Jul-2024 10:28:02 Event Stream AnalysisR...  Dams Rejected 12400

29-Jul-2024 10:08:38 Event Stream Analysis R... Information Technology Rejected 12310

29-Jul-2024 10:01:38 Event Stream Analysis R... Defense Industrial Base Rejected 12400

Users can perform the following tasks on the My Content tab:
e Upload Custom Content

¢ Delete Custom Content

¢ Download Custom Content

Upload Custom Content

The NetWitness Live My Content tab allows you to upload your own custom content, such as Log
Device and Event Stream Analysis, in the Live UI portal. Upon upload, NetWitness Live processes each
piece of content, which is displayed in a table that displays the type, the name of each content, the
created date, industry sector, platform version, and one of the following content statuses:

o Under Review: The content is uploaded successfully and submitted for review.
o Published: The NetWitness Live successfully processed and published the uploaded content.

o Rejected: NetWitness Live could not process the uploaded content. The uploaded content contains
invalid data, formatting errors, or malicious data.

Note: If the uploaded content file is rejected, check if the file contains any errors, fix them, and do
one of the following:

- You can delete the existing rejected content file from the UI and upload the rectified content file.
Follow steps 1- 12.

- You can upload the rectified content file with a different name.

o Failed: NetWitness Live could not process the uploaded content. The upload failure could be due to a
network outage or technical error.

Note:

- Users will receive an email notification and feedback from NetWitness Live, either approving or
rejecting their submission.

- Only the content that is in a published state will be available for the users to download.
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To Upload Custom Content
1. Log in to NetWitness Live using your Live account credentials.

2. Navigate to the My Content tab.

3. Click Upload Content.
The Upload Community Content dialog is displayed.

Upload Community Content

1 ' Identify Content

What content would you like to upload and share?
Upload file and provide details to describe the content.

RESOURCE TYPES

DESCRIPTION

4. Under the Identify Content section, provide the following details:

a. Resource Types: Select the required resource type from the drop-down list. The available options
are Log Device and Event Stream Analysis.

b. Under the Content file upload area, click and browse to the file that you want to upload, select
the file, and then click Open.

The format of a file depends on the type the user selects.

e For Log Device content, the supported file formats are xml, zip, and .envision.

o For ESA content, the supported file format is .esaa file exported from the NetWitness Platform
UI ESA Rule Builder with no extension.

Note:

- NetWitness Live recommends not to upload zipped files that contain more than one content
file for Log Device. This will cause the upload to fail. Currently, NetWitness Live only
supports uploading single content files.

- The maximum file size allowed for upload is 10 MB.
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C.

d.

€.

Name: Enter a unique name to identify or label the content.

Note: File name must not contain special characters or spaces.

Description: Enter a brief description of the content.

Under Provide contributor details, do one of the following:

o Select the checkbox Use Account owner name and email address. NetWitness Live will
automatically populate the relevant fields with the administrator user's live account details.

¢ Provide the name and email address of the contributor in the Contributor Name and Email
Address fields.

5. Click Upload and Continue.

6. Under the Define Content section, provide the following details:

Note: Only the Industry field is mandatory, and other fields are optional.

a.

Medium: Select one or more mediums from the drop-down list. The available options are
packet, endpoint, log, and log and endpoint.

Risk: Select the required risk from the drop-down list. The available options are High, Medium,
and Low.

Tags: Select one or more meta tags from the drop-down list to describe the content type. For
example, malware analysis.

Tactics: Select one or more MITRE ATT&CK Tactics from the drop-down list. After selecting
the tactics, you will be allowed to choose the appropriate techniques. For example, Command
and Control: TA0011.

Techniques: Select one or more MITRE ATT&CK Techniques from the drop-down list. For
example, Data Obfuscation: T1001.

Minimum Platform Version: Select the NetWitness platform version from the drop-down list.
Ensure that the custom content being uploaded is compatible with the minimum required
NetWitness platform version. For example, 12.4.0.0.

Industry: Select the required industry from the drop-down list to see the custom content relevant
to that industry. For example, Communications.

7. Click Save and Continue.
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Upload Community Content

Identify Content 2 | Define Content

Provide details to describe the content.

Overview
MEDIUMS

packet

Attributes
TAGS

malware analysis

TACTICS

Command and Control: TAOO11

TECHNIQUES

Data Obfuscation: T1001

MINIUMUM PLATFORM VERSION

12.40.0

INDUSTRY

Communications

Back Save and Continue

A preview of the list appears, displaying the first 15 items.

8. (Optional) Under the Add Dependency section, you can select the existing NetWitness content
available in the list, add it as a dependency, and additionally sort and filter the required content:

a. Sort the contents based on the following options from the drop-down list: Name (Ascending),
Name (Descending), Created (Oldest), and Created (New).

b. In the search field, enter the required content name or keywords and click Search. The required

contents will be displayed.

Note: Click the clear button to remove any text typed in the search field.

c. Select one or more contents from the available list and click Save and Continue.
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Upload Community Content

Identify Content Define Content 3 | Add Dependency

Add NetWitness Content as Dependencies Optional

Selected Content (1)

Name (Ascending)

CREATED

Apr 10,2019 7:20

Apr 10,2019 7:20:10 PM

11.1-11.2 Autorur
Task: i

Apr 10,2019 7:20:13 PM

- Apr 10,2019 7:20:18 PM

1-15 of 3200 items

NetWitness Rule

NetWitness

NetWitness Rule

NetWitness Rule

2 3 45 PAES

Back

>  15/page

Save and Continue

Note:

seamlessly.

page.

* You can navigate between pages using the page navigation options and view all the contents

* You can select the number of content entries per page using the drop-down list. By default,
15 rows are displayed per page. However, you can modify the number of rows displayed per

* You can use the scroll bar to navigate through the list of contents.

9. Under the Review And Confirm section, review the content details.

10. Click Back to return to the previous view. You can then edit any of the details you want to modify.

11. Click X to close the dialog.

Deploy Content
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12. Select the Terms and Conditions checkbox and click Save and Upload.

Upload Community Content

RISK

medium

Attributes

TAGS INDUSTRY SECTOR

malware analysis Communications

TACTICS TECHNIQUES

Command and Control Data Obfuscation

Dependencies

CREATED

11.1-11.2 Autoruns and Scheduled Tasks from Root of ProgramData Apr 10,2019 7:20:10 PM NetWitness Rule

TERMS AND CONDITIONS

& By checking the box, you agree to the

Back Save and Upload

Delete Custom Content

You can delete content if the content type is no longer valid. However, you can delete only the content
that you have uploaded.

Note:

* Deleting this content will remove the content permanently and cannot be restored. This action will
also impact any other content that uses it as a dependency.

* You can only delete one content file at a time.
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To delete the content
1. Select the content that you want to delete and click Delete Content.

NETWITNESS

tent
Content ecently updated and community content details here

Netwitness  Community
New

) RecentlyUpdated Showing My Content(37)

FirstWatch Content © . Upload Content @ Delete Content

[ — NAME 3 CREATED + vPE & INDUSTRY SECTOR 3
Event Strean y Food and Agriculture

10-Jul-2024 05:04:02 Log Device Energy

10-Jul-20 3:24 vent Strear s Chemical Rejected

09-Jul-2 vent Strea Commercial Facilities Rejected

09-J :59:42 Event Stream Analysis R Chemical

A confirmation message is displayed.
2. Click Delete.

This permanently removes the content from the NetWitness Live.

Download Custom Content

You can download any published content from the results displayed in the My Content tab.

Note: NetWitness provides no assurances about the quality and accuracy of the content beyond the
author's assurances.

To download the content

1. Click the name of the content that you want to download.

The Content Details dialog is displayed.
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Content Details

low

Attributes

TAGS

malware analysis

TACTICS

TA0011

Dependencies

INDUSTRY SECTOR

Communications

TECHNIQUES

T1001

CREATED

\utoruns and Scheduled Tasks from Root Ar 2019

7 0PM

@ Large files may take longer time to start the download.

2. Select the Terms and Conditions checkbox and click Download.

The content file is downloaded.
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Additional Procedures

This topic explains the additional procedures an administrator could choose to follow which are not
essential for the configuration or use of Live Services.

e Export Data to NetWitness

e Packaging Resources

e Manage Custom Feeds

¢ Creating a Custom Feed

¢ Create a STIX Custom Feed

¢ Creating and Managing an Identity Feed

Editing a Feed

e Removing a Feed

e Miscellaneous Live Services Procedures
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Export Data to NetWitness

In the Live Services Configuration panel, there is a Live Feedback Activity Log which enables you to
download the usage data required for Live Feedback. This is active regardless of the Live
Account configuration.

A NetWitness administrator can export the metrics in NetWitness for Live Feedback.

About Live Feedback

If the Live Account is not configured, you can manually upload the usage data to NetWitness. For more
information, see the "Configure Live Services Panel" topic in the System Configuration Guide.

You must first download the Live Feedback historical data, and then upload it to share with NetWitness.

Download Live Feedback Historical Data

To download the Live Feedback historical data:

A
1. Goto (Admin) > System.
2. In the options panel, select Live Services.

The Live Account screen is displayed which consists of the RSA Live Status and Download Live
Feedback Activity Log.

3. Click Live Feedback Activity Log.

The Live Feedback Activity Log window opens which allows you to download the required Live
Feedback historical data.

Live Feedback Activity Logs

Download monthly anonymized activity logs and manually upload to BSA secure portal,

For use only when live account is not configured.

L pate Range Last Download Date

(1 2017, June30-18

| Page |1 | of1 | | C PageSize 10 ~ Displaying 1 -1 of 1

4. Select one or multiple entries by selecting the checkboxes and click Download.

Note: If you select multiple entries in the history table, the Live Feedback data is downloaded into
a ZIP archive, consisting of individual JSON files for each month.

Share Telemetry Data to NetWitness

After you download the Live Feedback data, you can then upload it using the following procedure.
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Note:
- To download the Live Feedback data, see topic Download Live Feedback Historical Data.
- You can share data through NetWitness Live portal. For more information, Create Live Account.

To share the data to NetWitness

1. Log in to the NetWitness Live using your Live account credentials.

2. Click on the left panel.
The Telemetry Logs dialog is displayed.

L Telemetry Logs

Upload Live Feedback Activity Logs.

Click or drag-and-drop the .zip file to upload.

Note:
- You can upload only .zip files.
- Filename must be 255 characters or less and file size must be less than 128 MB.

3. Click or drag-and-drop a file onto this area to upload.

Deploy Content
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Packaging Resources

The primary use for creating and subsequently deploying a resource package is for customers using an
air gap network environment. In this case, you create a resource package on the network that is
connected to the internet, and then deploy the resource package on a more secure network.

Create and Deploy Resource Package Use Case

The basic steps are as follows:
1. Access NetWitness Live Services using an instance that is connected to the internet.
2. Create a Resource package as described below, adding whichever content items you need.

3. Copy the ZIP archive of the packages to your secure NetWitness instance, by using a thumb drive or
other manual copying process.

4. On the secure NetWitness instance, deploy the resource package. For more information, see Resource
Package Deployment Wizard.

Prerequisites to Create a Resource Package

A prerequisite for creating resource packages is configuration of the connection and synchronization
between the CMS server and NetWitness and the ability to search for resources in the User Interface.

Creating a Resource Package

The following procedure describes how to create a resource package, as a ZIP archive and save it to your
local file system.

To create a resource package:

1. Goto (Configure) > Live Content from the NetWitness UI.

2. Select the resources that you want to package in the Matching Resources grid.

42 Deploy Content



Live Services Management Guide

NETWITNESS

APTURE POLICIES

POLICIES

ESA RULES

CUSTOM FEEDS

NCIDENT RULES

INCIDENT NOTIFICATIONS

Search Criteria

Keywords

Category
[CJFEATURED

» CITHREAT

» CJIDENTITY

» [ ASSURANCE

» CJOPERATIONS
[CJSPECTRUM

[CJMALWARE ANALYSIS

Resource Types

Medium

Required Meta Keys
Generated Meta Values
Resource Created Date:

Start Date B End Date

Resource Modified Date:

how Results "8 Deploy

Subscribed Name

no

RSA OSINT IP Threat Intel F.,
RSA OSINT Non-IP Threat In.
Powershell Runs Command.
Runs ACL Management T...
AWS Security Hub Log Col...

NWFL_fw:outbound-networ..

15027002 - Compliance Rep...

Direct Login By A Watchlist ...
11.3 Endpoint Indicators by..
RSA Certificate Manager Lo..
Top Outbound Source IP
Runs Chained Command .
Enumerates Local Groups
SecurlD Cloud Device Regis.
File Transport over ICMP
fingerprint_job

Cisco Ironport ESA Log Coll...
HyTrust

Bit9 Log Collector Configur...
Event Viewer Executes Unc...

Microsoft Audit Collection S...

663 Matching Resources

A Subscribe

Created

2020-09-10 7:53 PM
2020-09-10 7:53 PM
2019-04-10 2:23 PM
2019-04-10 2:29 PM
2020-07-28 6:17 PM
2012-04-23 12:09 PM
2014-06-17 2:45 PM
2018-03-27 2:01 PM
2019-04-10 1:51 PM
2013-11-22 6:35 AM
2014-07-24 10:56 AM
2019-04-10 2:30 PM
2019-04-10 2:16 PM
2019-04-17 5:54 AM
2014-07-21 5:31 PM
2013-09-12 2:24 PM
2013-11-22 6:13 AM
2014-02-14 3:34 AM
2013-11-226:11 AM
2019-04-10 2:17 PM

2014-02-14 3:41 AM

| 3 Package

Updated

2022-09-06 4:30 AM
2022-09-06 4:30 AM
2020-01-23 4:21 PM
2019-04-10 3:09 PM
2020-07-29 7:52 AM
2017-11-11 3:37 AM
2017-09-23 5:41 AM
2018-07-24 5:31 PM
2019-04-10 2:02 PM
2017-09-13 11:40 AM
2017-09-23 5:49 AM
2019-04-10 3:10 PM
2019-04-10 3:06 PM
2019-04-17 5:56 AM
2017-11-11 3:37 AM
2017-09-23 5:37 AM
2017-09-13 11:37 AM
2017-09-13 11:07 AM
2017-09-13 11:37 AM
2019-04-10 3:07 PM

2020-05-04 2:06 PM

Type
Feed

Feed

Application Rule
Application Rule
Log Collector
Application Rule
NetWitness Report
Event Stream Anal.
NetWitness Rule
Log Collector
NetWitness Rule
Application Rule
Application Rule
Application Rule
Application Rule
Lua Parser

Log Collector

Log Device

Log Collector
Application Rule

Log Device

3. Select some or all the resources that are listed in the Matches Resources pane.

4. Select * Package -

> Create.

Description

This feed contains IP Address (IPv
This feed contains Non-IP Addres
Powershell running command pr
Running ACL management tool
Log Collector configuration con
NWFL App Rule to support Inforn
1SO 27002 establishes guidelines
A successful interactive or remot¢
Number of risk indicators associe
Log Collector configuration conte
Summarizes a list of outbound sc
Running chained command shell
Enumeration of local groups can
Raises an alert when RSA SecurIC
Detects files transported over ICA
Identifies windows job task schec
Log Collector configuration conte
Log device content for event sour
Log Collector configuration conte
Event viewer executing uncommc

Log device content for event sour ¥

3

NetWitness creates a .zip archive that contains the selected resources and downloads it to your default
download folder. NetWitness gives the package a generic name. You should rename it when you save it
so that it identifies the resources contained in the package.

Creating Threat Package

The following procedure describes how to create a resource package that contains all the content that is

categorized as Threat. Then we rename it, using the type of content and date.

1. Goto

(Configure) > Live Content.

2. From the Category section, select Threat.

Select all items returned by clicking on the checkbox in the column header row of the Matching

Resources pane.

Deploy Content
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NETWITNESS
SUBSCRIPTIONS CAPTURE POLICIES POLICIES 3 CUST! S NCIDENT RULES NCIDENT NOTIFICATIONS
Search Criteria Matching Resources
Keywords & Show Results '8, Deploy | 3 Package
Certain services are managed by Centralized Content Management(CCM). To manage content on those services, ¢
Category 3 Subscribed Name Created Updated Type Description
"] FEATURED ¥ no Injecting Web Shell to Col... ~ 2022-10-27 12:29 PM 2022-11-29 3:47 PM Application Rule Identifies shell processes such as 'cmd.exe' or powt
¥ no Endpoint Pack 2019-04-10 3:45 PM 2023-03-08 3:22 PM Bundle Deploying this bundle will download all of the cont
» CJ Attack Phase ¥ no Host Traffic to External IP... ~ 2022-06-08 6:53 PM 2023-08-31 6:34 AM ication Rule Many , once promising a
» D Malware ¥ no Runs Powershell Comma... ~ 2022-10-18 6:28 AM 2022-11-29 5:39 PM Application Rule  Running remote powershell command can be an in
» CJIDENTITY ¥ no Possible Port Scanning D... 2022-09-15 3:56 PM 2023-06-15 2:57 PM Application Rule Adversaries may execute active reconnaissance sc
» - ASSURANCE ¥ no Possible SMB Scanning D...  2022-09-15 3:54 PM 2023-06-15 2:57 PM Application Rule  Adversaries may execute active reconnaissance sc:
» (] OPERATIONS ¥ no Packet Starter Pack 2016-12-30 5:53 PM 2023-01-19 4:04 PM Bundle This pack contains a set of starter content specific
[CISPECTRUM ¥ no Known Threats Pack 2017-06-06 4:28 PM 2023-01-19 3:47 PM Bundle This pack contains a set of content specific to knov
] MALWARE ANALYSIS ¥ no 0365 - Mass SharePoint Fi...  2022-12-07 2:28 PM 2022-12-21 6:11 PM Event Stream An...  This rule triggers when the specified number of Sh.
¥ no EC2- Multiple instances t...  2021-09-14 6:55 AM 2021-09-14 6:55 AM Event Stream An...  This rule triggers when specified number of EC2 in:
Resource Types ¥ no 11.3 Rarest Code Signing ... 2019-04-10 1:52 PM 2019-04-10 2:02 PM NetWitness Rule Details of Child Processes of web server. Web Shell.
v ¥ no Confluence Web Shell Act...  2022-10-27 11:52 AM 2022-10-27 11:52 AM Application Rule Identifies shell processes such as ‘cmd.exe’ or Pow«
Medium ¥ no 11.3 Autoruns and Sched...  2019-04-10 1:51 PM 2019-04-10 2:02 PM NetWitness Rule Attackers will often use registry autoruns and sche
v ¥ no GCP - Multiple vm instanc...  2022-02-04 11:47 AM 2022-02-04 11:47 AM Event Stream An...  This rule triggers when the specified number of VV
¥ no Suspicious sdiagnhost.ex...  2022-07-20 6:10 PM 2022-10-27 7:25 AM Application Rule This rule alerts on Scripted Diagnostics Native Hos
Required Meta Keys ) : " e ) ]
¥ no 11.3 Endpoint Indicators ... 2019-04-10 1:51 PM 2019-04-10 2:02 PM NetWitness Rule Number of risk indicators associated with each ho:
¥ no NetWitness Administrati... 2018-07-18 9:20 PM 2018-07-18 9:23 PM NetWitness Rule This Rule gives a summary of event types and sub 1
Generated Meta Values ¥ no Potential APT Service Inst...  2015-07-02 7:11 AM 2017-09-23 5:36 AM Event Stream An... 10.4 or higher. Detects a host making a connection
¥ no Outbound BazarLoader D...  2022-01-28 2:50 PM 2022-01-28 2:50 PM Application Rule BazarLoader (Also known as Baza, BazaLoader) is a
Resource Created Date: A~ no Modifies Windows Securi...  2022-10-18 6:21 AM 2022-10-18 6:21 AM Application Rule  This rule detects a Non-Microsoft binary modifying .,
»
393 Matching Resources

4. Select * Package > Create.

A ZIP archive is saved to your Downloads folder. For example,
resourceBundle8740753704980701969.zip.

5. Rename the package to something meaningful. For example, in this case, you cold change the
package name to threatResourceBundle 2018 01 31.zip (assuming today's date is January 31,
2018).

The resource package is now available for later deployment.

Deploying a Threat Package

This procedure assumes that you saved a package named threatResourceBundle 2018 01 31.zip, as
described in the previous section. It describes how to deploy a saved resource package

1. Goto (Configure) > Live Content.

2. In the Matching Resources pane, select A Package > Deploy.

3. Click Browse and navigate to the threatResourceBundle 2018 01_31.zip file that were created
earlier.
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Resource Package Deployment

Package Resources Services Review Deploy|

Resource Bundle | threatResourceBundle_2018_01_31.zip Browse

Cancel Next

4. Click Next.
The Resources page displays details for the resources in the package.
5. Click Next.
The Services page displays two tabs, Services and Groups, which provide a list of services and

44
service groups that are configured in the (Admin) > Services view. The columns are a subset of
the columns available in the Services view.

6. Select the services on which you want to deploy the content. You can select any combination of
services and service groups.

Deployment Wizard

Resources Services Review Deploy

[ # Name ~ Type

# UlEndpoint Other

Cancel Previous Next

7. Click Next.
The Review page is displayed.

Note: Make sure that you have selected correct resources and the services to which you want to
deploy them.

8. Click Deploy to complete the deployment process. Alternatively, you can choose Cancel or Previous
to either cancel the deployment or go back to the previous screen.
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Manage Custom Feeds

The custom feed capability is implemented using the Custom Feed Wizard in NetWitness, allowing you
to quickly populate Decoders with custom and identity feeds.

Custom Feed Creation

You can use the Live > Custom Feeds > Setup Feed > Configure a Custom Feed wizard to create and
deploy Decoder feeds based on deterministic logic that offers the meta keys specific to the selected
Decoders and Log Decoders. Although the wizard guides you through the process to create both on-
demand and recurring feeds, you should understand the form and content of a feed file when you create a
feed.

Feed file names in NetWitness are in the form <filename>. feed. To create a feed, NetWitness
requires a feed data file in .csv or .xm1 (for STIX) format and a feed definition file in . xm1 format,
which describes the structure of a feed data file. The Configure a Custom Feed wizard can create the
feed definition file based on a feed data file, or based on a feed data file and the corresponding feed
definition file.

The files that you use to create an on-demand feed must be stored on your local file system. The files
used to create a recurring feed must be stored at an accessible URL, whence NetWitness can fetch the
most current version of the file for each recurrence. After a NetWitness feed is created, you can
download the feed to your local file system, edit the feed files, and edit the NetWitness feed to use the
updated feed files.

Sample Feed Definition File

This is an example of a feed definition file named dynamic_dns.xml, which NetWitness creates based
on your entries in the Feed wizards. It defines the structure of the feed data file named dynamic
dns.csv.

Note: The feed file path should be . csv regardless of the Feed Type (Default or STIX).

Sample Feed Definition File

<FDF xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="feed-definitions.xsd">
<FlatFileFeed name="Dynamic DNS Domain Feed"
path="dynamic_dns.csv"
separator=","
comment="4#"

version="1">

<MetaCallback
name="alias.host"
valuetype="Text"
apptype="0"
truncdomain="true"/>

<LanguageKeys>
<LanguageKey name="threat.source" valuetype="Text" />
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<LanguageKey name="threat.category" valuetype="Text" />
<LanguageKey name="threat.desc" valuetype="Text" />
</LanguageKeys>

<Fields>

<Field index="1" type="index" key="alias.host" />
<Field index="4" type="value" key="threat.desc" />
<Field index="2" type="value" key="threat.source" />
<Field index="3" type="value" key="threat.category" />

</Fields>

</FlatFileFeed>

</FDF>

Feed Definition Equivalents for Custom Feed Wizard Parameters

The NetWitness Feeds wizard provide options to define the structure of the data feed file. These
correspond directly to attributes in the feed definition (.xml) file.

NetWitness

Parameter

Feed Definition File Equivalent

Feed Type

Feed Task Type

Name

File/ Browse

(STIX, Recurring)
Trust All Certificate

(STIX, Recurring)

Certificate/Browse

XML Feed File

Separator

Define Feed tab

Select: Default - to define a feed based on a . csv formatted feed data file.
STIX - to define a feed based on STIX formatted . xml file.

Select: Adhoc - to create an on-demand feed. Recurring - to create a feed that
recurs automatically.

Enter a custom feed name in the feed data file that corresponds to the
flatfeedfile name attribute in the feed definition file; for example,
Dynamic DNS Test Feed,

Enter a name of the feed data file that corresponds to the flatfeedfile
path attribute in the feed definition file; for example, dynamic_dns.csv,

Select Trust All Certificate, if you do not want to validate the REST server
certificate. This option is enabled by default (checked).

For client authentication with the REST URL, in the Certificate field, click
Browse and select the self signed certificate. The supported certificate formats
are .cer, .crt with Base64 & DER encoded files.

Define Feed tab - Advanced Options
Enter a name of the feed definition file, for example, dynamic_dns.xml,

The separator character used to separate attributes in the feed data file. It
corresponds to the flatfeedfile separator in the feed definition file; for
example, a comma.
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NetWitness

Parameter

Feed Definition File Equivalent

Comment

Remove STIX data
older than

Select Services tab

(Define Columns tab,
Define Index) Type

(Define Columns tab,
Define Index) CIDR

(Define Columns tab,
Define Index)
Service Type

(Define Columns tab,
Define Index)
Truncate Domain

(Define Columns tab,
Define Index) Ignore
Case

(Define Columns tab,

The character used to identify a comment in the feed data file. It corresponds
to the flatfeedfile comment attribute in the feed definition file; for
example, #.

The number of days for which the STIX packages downloaded from TAXII
server have to be stored. The STIX packages older than the specified number
of days are deleted automatically. The default value is 180 days, which is also
the maximum.

Select the services to which you want to send the data feed.

The type of lookup value in the index position of the feed data file.

IP means that each row in the feed data file contains an IP address in the
lookup value position. The IP value is in dotted-decimal format (for example,
10.5.187.42).

IP Range means that each row in the feed data file contains a range of IP
addresses in the lookup value position. The IP range is in CIDR format (for
example, 192.168.2.0/24). Non IP means that the each row in the feed data file
contains a metadata value other than IP address in the lookup value position.
The Service Type and Truncate Domain, and Callback Keys fields become
active for a Non IP index.

Specifies that the IP value in the lookup position is in CIDR format. The
CIDR attribute sets the IP address format in the field to Classless Inter-
Domain Routing (CIDR) notation.

For a Non IP index, the integer service type to filter meta lookups. It
corresponds to MetaCallback apptype attribute in the feed definition file. A
value of 0 indicates no filtering by service type.

For a Non IP index, for meta values that contain domain names (for example,
hostnames), the system can strip off the host specific element in the data.
Truncate Domain corresponds to the MetaCallback truncdomain attribute. If
the value is www.example.com, it is truncated to example.com. A value of
False selects no truncation, and True selects truncation.

If this option checked, the feed will ignore the case.

For a Non IP index, the available meta keys to match on instead of ip.src/ip.dst

Define Index) (the defaults for IP index type) are selectable from the drop-down list.

Callback Keys The Callback Key corresponds to the MetaCallback name attribute, and
the index column of the csv file must contain data that can match the chosen
meta key. For example, if the username meta key is chosen, the index column
of the csv file needs to be populated with users to be matched.
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NetWitness

Parameter

Feed Definition File Equivalent

(Define Columns tab, Identifies the column in the feed data file that provides the lookup value for the

Define Index) row. Each position in each row of the feed data file is identified by a Field

Index Column index attribute in the feed definition file. A field with an index of 1 is the first
entry in a row, the second field has an index of 2, the third field has an index
of 3, and so on. You can select multiple index columns, if the Feed Type is
STIX and Index Type is Non IP. When you select multiple index columns the
values from all the selected columns are merged in the first index column that
you selected.

(DEFINE VALUES) The name of the LanguageKey, as defined in the feed definition file, for

Key which meta is created from this row of the feed data file. It corresponds to the
Field Kkey attribute in the feed definition file. A key applies only to a field
whose type is set to value, In the feed definition file, there is a list of
LanguageKeys from index.xml, or a summary name if Source Name and
Destination Name are used. For example, reputation is a summary name for
reputation.src and reputation.dst). This value is referenced by the Field key
attribute.
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Creating a Custom Feed

This topic provides instructions for creating a custom feed using a .csv or STIX formatted feed data file
in NetWitness. For more information about STIX and creating a STIX custom feed, see Create a STIX
Custom Feed.

You can easily create a custom feed using the Custom Feed wizard. To complete this procedure, you
need a feed data file in . csvor .xm1 format. If you also have an associated feed definition file

in .xml format, which describes the structure of the feed data file, you can use the feed definition file to
create a feed. The Custom Feed wizard can create the feed based on a feed data file, or based on a feed
data file and corresponding feed definition file.

After completing this procedure, you will have created a custom feed.

The feed data file (.csv or STIX (.xm1)) and optionally the feed definition file (. xm1) must be
available on the local file system for an on-demand custom feed. For a recurring custom feed, the files
must be available at a URL that is accessible to the NetWitness server.

Note: Any feeds that are created will be automatically pushed to Context Hub as Lists. The lists can be
looked up in the context lookup panel of the Respond and Investigate pages. If Context Hub is not
configured or the service is down, then the feeds will be pushed to Context Hub the next time the
server is available.

To create a custom feed:

1. Goto (Configure) > CUSTOM FEEDS.
The Custom Feeds view is displayed.

NETWITNESS

INCIDENT RULES NCIDENT NOTIFICATIONS ~ MORE v

+
Name Trigger Disk Usage Created Last Run Time Status Progress
B TEST Once Completed —
B TEST Once Completed ——
o te Once Completed —
B onlydom Once Completed —
o PCAP Once Completed —

2. In the toolbar, click +
The Setup Feed dialog is displayed.

Setup Feed

@ Custom Feed

) ldentity Feed
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3. To select the feed type, click Custom Feed and Next.
The Configure a Custom Feed wizard is displayed, with the Define Feed form open.

(Configure a Custom Feed

Define Feed Select Services Define Columns Review
Feed Type @ csv O STIX
Feed Task Type @' Adhoc Recurring

Name *

Upload As Csv |
File Feed

File * Select File Browse

Advanced Options

Reset Cancel Next

4. To define a feed based on a . csv formatted feed data file, select CSV in the Feed Type field.

5. To define an on-demand feed task that executes once, select Adhoc in the Feed Task Type field and
do one of the following:

a. (Conditional) To define a feed based on a .csv formatted feed data file, type the feed Name.
b. Select the checkbox Upload As CSV File Feed, if required.

c. Select a .csv content File from the local file system, and click Next.
d. (Conditional) To define a feed based on an XML feed file, select Advanced Options.
The Advanced Options are displayed:

Configure a Custom Feed

Define Feed Select Services Define Columns Review

Feed Type OfeY] STiX
Feed TaskType @ Adhoc Recurring
Narme *

Upload As Csv

File Feed !

File * Select File Browse

) Advanced Optio

XML Feed File | Select File Browse
Separator

Comment #

Reset Cancel Next

e. Select an XML feed file from the local file system, choose the Separator (default is comma), and
specify the Comment characters used in the feed data file (default is #), and click Next.

f. The Select Services form is displayed. This is an example of the form for a feed based on a feed
data file with no feed definition file. If you are defining a feed based on a feed definition file, the
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Define Columns tab is not needed.

Configure a Custom Feed

Define Feed Select Services Define Columns

Services
O i Name ~ Address Type
Ll g Decoder
Ll g - Decoder
Ll g Decoder
L g Log Decoder
O s Decoder
L & . Log Decoder
O s Decoder
L & Decoder
Ll g Decoder
O . Log Decoder
Ll g Log Decoder
O . Decoder
Ll g Decoder
O« A Log Decoder
Reset Cancel Prev Next

6. To define a recurring feed task that executes repeatedly at specified intervals, during a specified date
range.

a. Select Recurring in the Feed Task Type field.
The Define Feed dialog includes the fields for a recurring feed.

Configure a Custom Feed

Define Feed Select Services Define Columns Review
Feed Type @ csv O sTix
Feed TaskType O Adhoc ® Recurring
Name * TestFeed
Upload AsCsv
File Feed
URL* Verify
[ Authenticated
[ Use Proxy
Recur Every ¢ v
[ Date Range
) Advanced Options
XML Feed File | Select File Browse
Separator
Comment #
Reset Cancel Next
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b. In the URL field, enter the URL where the feed data file is located, for example,
http://<hostname>/<feeddatafile>.csv, and click Verify.

NetWitness verifies the location where the file is stored, so that NetWitness can check for the
latest file automatically before each recurrence.

c. (Optional) If the URL has restricted access and requires authentication using your username and
password, select Authenticated.

NetWitness provides your user name and password for authentication to the URL.

d. If you want the NetWitness server to access the Feed URL through a proxy, select Use Proxy.
For more information on configuring a proxy, see the Configure Proxy for NetWitness topic in
the System Configuration Guide. By default, the Use Proxy checkbox is not selected.

NOTE:
If you are using an HTTPS based feed server, ensure that you import and install the certificates.
For more information, see Import Certificates for HTTPS Service

e. To define the interval for recurrence, do one of the following:
¢ Specify the number of minutes, hours, or days between recurrences of the feed.

¢ Specify recurrence every week, and select the days of the week.

f. To define the date range for the execution of the feed to recur, specify the Start Date and time
and the End Date and time.

Configure a Custom Feed

Define Feed Select Services Define Columns Review

Feed Type ® Default STIX

Feed Task Type O Adhoc ® Recurring

Name * Testfeed

URL* https://gasa2.netwitness.local/live/feeds Verify
Authenticated

Use proxy

XML Feed File Browse
Separator

Comment

Reset Ccancel Next

7. (Conditional) If you want to define a feed based on an XML feed file:
o Type the feed Name, select Advanced Options.
The Advanced Options fields are displayed.

o Select an XML feed file from the local file system, choose the Separator (default is comma),
specify the Comment characters used in the feed data file (default is #) and click Next.
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8. To identify services on which to deploy the feed, do one of the following:

The Select Services dialog is displayed.

Configure a Custom Feed

Define Feed

Services m
[l # Name ~
O
O
O &

O &
=g
O
Og
O &

O &

O &

O &

Ds
O &

O«

Select Services

Define Columns

Decoder
Log Decoder
Decoder
Log Decoder
Decoder
Decoder
Decoder
Log Decoder
Log Decoder
Decoder
Decoder

Log Decoder

Review

a. Select one or more Decoders and Log Decoders, and click Next.

b. Click the Groups tab and select a group. Click Next.

The Define Columns dialog is displayed.

9. To map columns in the Define Columns form:

a. Define the Index type: IP, IP Range, or Non IP, and select the index column.

b. (Conditional) If the index type is IP or IP Range and the IP address is in CIDR notation, select

CIDR.

c. (Conditional) If the index type is Non IP, additional settings are displayed. Select the service
type and Callback Keys, and optionally select the Truncate Domain and Ignore Case option.
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Configure a Custom Feed

Define Feed Select Services Define Columns Review

Type Owp (0 IP Range ® Non IP

Index Column 1 v ServiceType 0 ¢ [¥ Truncate Domain Ignore Case

CallbackKey (S) |

K
0s

access.point
Column | [

Define Value
accesses
Key action
SRM_Sa alert

ANCEsT| alert.id Pe
| alias.host |
" alias.ip
< alias.ipvé
alias.mac
asn.dst

asn.src

srao Lo .

Reset Cancel Prev Next

d. Select the language key to apply to the data in each column from the drop-down list. The meta

displayed in the drop-down list is based on the meta available for the service define values. You
can also add other meta based on advanced expertise.

Configure a Custom Feed

Define Feed Select Services Define Columns Review
vetin ge
Type Ow O IP Range @® Non IP
Index Column 1 v Service Type 0 ¢ [¥ Truncate Domain Ignore Case
Callback Key (S) action @ v
vetine ues
Column 2 3 4
Key threat.source v threat.category v threat.desc
SRM_SaaS_ES MXASSETInterface AddChange EN
ANCESTOR ASSETNUM ASSETTAG ASSETTYPE
cent45 9164
cent45 9164
Reset Cancel Prev Next
Deploy Content
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Note: When a custom feed gets converted into a context hub list, you must map at least one
meta key with one or more meta types by mapping a column header with a meta. However, you
can add or edit the entity mapping of a list by clicking % in the Lists tab. For more
information, see the Context Hub Configuration Guide.

e. Click Next.
The Review dialog is displayed.

Configure a Custom Feed

Define Feed Select Services Define Columns Review

Testing

AssetsimportCompleteSample.csv

Log Decoder, Decoder

Other
action
true

0

1 2 3 4

Index threatsource threat.category threat.desc

Reset Cancel Prev Finish

10. Anytime before you click Finish, you can:
¢ Click Cancel to close the wizard without saving your feed definition.
¢ Click Reset to clear the data in the wizard.
¢ Click Next to display the next form (if not viewing the last form).
¢ Click Prev to display the previous form (if not viewing the first form)
11. Review the feed information, and if correct, click Finish.

12. Upon successful creation of the feed definition file, the Create Feed wizard closes, and the feed and
corresponding token file are listed in the Feed grid and progress bar tracks completion. You can
expand or collapse the entry to see how many services are included, and which services were
successful.

Note: When you create a feed, and if there is no entity mapping done such as in case of custom meta,
then those columns in the List will not have entity mappings in Context Hub. You have to manually
map the entities from the List page.

Import Certificates for HTTPS Service

Import certificates to communicate with the HTTPS services:
1. SSH to the NW node and copy the CA certificate located in the following directory:
Jetc/pki/ca-trust/source/

2. Execute the following command to update the certificates:
update-ca-trust
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3. Execute the following command to add the certificate to the java keystore:
keytool -list -keystore /etc/pki/java/cacerts -storepass changeit

4. Restart the service on the NW node.

| & head

Note: Perform the procedure for all the HTTPS servers.
Example: HTTPS proxy server and HTTPS feed server.
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Create a STIX Custom Feed

You can create a custom feed using a .csv or STIX formatted feed data file in NetWitness.

Note:
- NetWitness supports Structured Threat Information Expression (STIX) 1.0, 1.1 and 1.2 versions.
- NetWitness supports STIX V2 (2.0 and 2.1) indicators from 12.5 version or later.

Structured Threat Information Expression (STIX™) is a structured language for describing cyber threat
information so it can be shared, stored, and analyzed in a consistent manner. For more information about
STIX, see https://oasis-open.github.io/cti-documentation/.

Caution: If STIX recurring feed is configured and you update Security Analytics from 10.6.x to
NetWitness 12.5 , you must re-configure the STIX recurring feed.

In NetWitness Platform, STIX feeds are supported. You can upload STIX content in different formats
based on its version. For the older versions the format is ".xml". From version 12.5 or later, you can
upload in ".json" (STIX V2 indicators) file. The constructs such as Indicator Title and Description,
Observable Title and Description, and Indicator Sightings information are parsed from STIX and pushed
to the decoders or log decoders that are selected during feed configuration. Information such as IP
addresses, File hashes, Domain names, URIs, and Email addresses are extracted from the STIX
observable to be included in the feed.

Make sure the following criteria are met before you upload the STIX file:
1. Only STIX Observables with property values in the "Equals" operator
2. The uploaded STIX xml or json file must have only one STIX Package

TAXII (Trusted Automated eXchange of Indicator Information) is the main transport mechanism for
cyber threat information represented in STIX. Using the TAXII services, organizations can share cyber
threat information in a secure and automated manner.

The STIX and TAXII communities work closely together to ensure that they continue to provide a full
stack for sharing threat intelligence.

Apart from TAXII server, STIX data can also reside on REST server and you can fetch STIX file from
the REST server by providing the URL of the REST server. For example,
http://stixrestserver.internal.com.

The feed data file (. csv or STIX (.xml or .json)) and optionally the feed definition file (. xm1) must be
available on the local file system for an on-demand custom feed. For a recurring custom feed, the files
must be available at a URL that is accessible to the NetWitness server.

In NetWitness Platform, STIX (.xml) and (.json) feed of type Indicators or Observable which contains
the properties such as the IP addresses, File hashes, Domain names, URIs and Email addresses are
supported. The properties values in the Equals operator is only supported. The STIX constructs that are
parsed are Indicator Title and Description, Observable Title and description and Indicator Sightings
information. The STIX (.xml and .json) with a single STIX Package is only supported."

To create a STIX custom feed:

1. Goto (Configure) > CUSTOM FEEDS.
The Custom Feeds view is displayed.
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NETWITNESS

o

+
Name Trigger Disk Usage Created
B TEST Once - 2019-07-1313
@ TEST2 Once
o te Once
B onlydom Once
B PCAP Once - 2019-07-140

NCIDENT RULES

NCIDENT NOTIFICATIONS ~ MORE v

Last Run Time Status Progress
Completed CEE——
Completed CEEE—
Completed CEEE—
Completed CEEE—
Completed CEEE—

2. In the toolbar, click +
The Setup Feed dialog is displayed.
Setup Feed

(® Custom Feed

Identity Feed

3. To select the feed type, click Custom Feed and Next.

The Configure a Custom Feed wizard is displayed, with the Define Feed dialog open.

The following figure represents a datasource containing STIX version 1.2 or lower indicators

uploaded in XML format.
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Configure a Custom Feed

Define Feed Select Services

Define Columns

[] Date Range

Advanced Options
XML Feed File  Select File
Separator ~

Comment #

Reset

Feed Type 0 csv ® STIX

Name * STIXFiles

STIX Source All STIX V1 Files v
Recur Every 5 ¢ v

Browse

Cancel

Review

Next

The following figure represents a datasource containing STIX version 2.0 and 2.1 indicators

uploaded in JSON format.
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Configure a Custom Feed

Define Feed Select Services Define Columns Review
Feed Type O csv ® STIX
Name * STIXFiles
STIX Source All STIX V2 Files v
Recur Every 5 ¢ v
[} Date Range
Advanced Options

XML Feed File Select File Browse

Separator ~

Comment #

»

Reset Cancel Next

4. Enter the following details:

a. Feed Type: Select STIX, to define a feed based on a STIX formatted .xml or . json file.

b. Name: Type the feed name, to define a feed based on STIX formatted . xm1 or .json file.

c. STIX Source:Select a STIX data source from the drop-down which is added in Context Hub.

d. Recur Every: Specify a recurring feed task that executes repeatedly at specified intervals.

Note: NetWitness verifies the connection to the server, so that NetWitness can check for the latest
file automatically before each recurrence.

e. Date Range: Select the checkbox and specify the date range for the feed task to recur.
5. (Optional) Select Advanced Options,to define a feed based on an XML feed file.
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a. XML Feed file: Browse and select an XML feed file from the local file system.
b. Separator: Choose a separator (default is comma).

c. Comment: Specify the comment characters used in the feed data file (default is #).

6. Click Next.

7. The Select Services dialog is displayed. This is an example of the form for a feed based on a feed
data file with no feed definition file. If you are defining a feed based on a feed definition file, the
Define Columns tab is not needed.

[Configure a Custom Feed

Define Feed Select Services Define Columns Review

Services Group:
¥ & Nam Add Type

¥ & Log Decoder
¥ Decoder

8. To identify services on which to deploy the feed, do one of the following:

a. Select one or more Decoders and Log Decoders, and click Next.

b. In case of STIX feed, Context Hub will be selected by default and you are not allowed to deselect
it. In addition, you can select one or more Decoders and Log Decoders and click Next or Click
the Groups tab and select a group. Click Next.

If the data from the STIX server is large, the following message is displayed:

Fetching sample data is taking longer than expected.
Choose one of the following options

Continue to Wait Map without Sample data

* If you click Continue to Wait, it continues to wait till the sample data is fetched or timeout
(10 minutes) whichever is sooner. In case of timeout no sample data is retrieved even after 10
minutes.

e If you click Map Without Sample data, the mapping column is displayed without any sample
data.

The Define Columns dialog is displayed.
9. To map columns in the Define Columns form:
a. Define the Index type: IP, IP Range, or Non IP, and select the index column.

b. (Optional) If the index type is IP or IP Range and the IP address is in CIDR notation, select
CIDR.
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c. (Optional) If the index type is Non IP, additional settings are displayed. Select the service type
and Callback Keys, and optionally select the Truncate Domain option.

Configure a Custom Feed

Define Feed Select Services Define Columns Review

Type @ 1p Non IP

Index Column(S) 10 v [_] cIbr

Key v v v v

Header Indicator Title Indicator Description Observable Title Observable Description

Some Indicator <p>Some Indicator</p> domain:domainl.exa... domain:domain1.exa...
Some Indicator <p>Some Indicator</p>  domain:domain2.exa... domain:domain2.exa...
indicator-domain auto domain test domain test domain desc

Another Indicator <p>Another Indicator... ~ domain:domain3.exa... domain:domain3.exa...

Reset Cancel Prev Next

Note:

- If the Index Type is Non IP, you can select multiple index columns in the Index Column(S).
The values from all the selected columns are merged in the first index column that you selected
and the merged values are pushed to the Log Decoder for parsing. For example, in the Index
Column(S) if you select 2,4,7 as index columns the values from the 2,4 and 7 columns are
merged in the column 2 and the values are pushed to Log Decoder for parsing.

- Indexing cannot be done for the columns such as Indicator Title, Indicator Description,
Observable Title, Observable Description, as the look up cannot be performed for those
columns.

d. Select the language key to apply to the data in each column from the drop-down list. The meta
displayed in the drop-down list is based on the meta available for the service define values. You
can also add other meta based on advanced expertise.

e. Click Next.
The Review dialog is displayed.
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Configure a Custom Feed

Define Feed Select Services Define Columns Review

FILESTIX
FILESTIX-stix.xml

PH - Decoder, LH - Log Decoder

false

10 24

Index event.desc

Reset Cancel Prev Finish

10. Anytime before you click Finish, you can:

¢ Click Cancel to close the wizard without saving your feed definition.

¢ Click Reset to clear the data in the wizard.

¢ Click Next to display the next dialog (if not viewing the last form).

¢ Click Prev to display the previous dialog (if not viewing the first form)
11. Review the feed information, and if correct, click Finish.

12. Upon successful creation of the feed definition file, the Create Feed wizard closes, and the feed and
corresponding token file are listed in the Feed grid and progress bar tracks completion. You can
expand or collapse the entry to see how many services are included, and which services were
successful.

NETWITNESS g R E &0 5

INCIDENT RULES NCIDENT NOTIFICATIONS

+
Name Trigger Disk Usage Created Last Run Time Status Progress
@ TEST Once Completed —
@ TEST. Once Completed —
o te Once Completed ——
onlydom Once Completed —
o PCAP Once Completed

Note: Health and Wellness raises alerts when the available heap memory of Context Hub server is
critically low and the status displays as unhealthy due to low memory. For more information on how to
troubleshoot the OutOfMemoryError on the Context Hub Server, see "Troubleshooting” in the Live
Services Management Guide.
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MetaCallback Feeds using CIDR Index Range for IPv4 and IPv6

You can use CIDR index ranges for IPv4 and IPv6 in custom MetaCallback feeds. As with other custom
feeds, you must create feed data file in .csv format, and a feed definition file in .xml format.

Note: Using MetaCallback feeds with CIDR index ranges is supported only through the Advanced
Configuration wizard or the REST interface.

The following example shows the content of both a .csv file and an .xml file for a MetaCallback feed
using CIDR index ranges for IPv4 or IPv6.

CSV File Content

192.168.0.0/24, Sydney
192.168.1.0/24, Melbourne

XML File Content

<?xml version="1.0" encoding="UTF-8"?><FDF
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalLocation="feed-definitions.xsd">

<FlatFileFeed name="ip_test" path="ip_test.csv" separator="," comment="#">
<MetaCallback name="DstIP" valuetype="IPv4" apptype="0" truncdomain="false">
<Meta name="ip.dst"/>

</MetaCallback>

<LanguageKeys>

<LanguageKey name="alert" valuetype="Text" />

</LanguageKeys>

<Fields>

<Field index="1" type="index" range="cidr"/>

<Field index="2" type="value" key="alert" />

</Fields>

</FlatFileFeed>

</FDF>

Note: To configure a CIDR index range for feeds with single or multiple MetaCallbacks of value type
[Pv4 or IPv6, the field of type index MUST contain a range attribute with range="cidr". Also,
configuring "cidr" index ranges for feeds with MetaCallbacks of multiple different value types is not
supported.
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Creating and Managing an Identity Feed

You can easily create an Identity feed and populate it to selected Decoders and Log Decoders. After
completing this procedure, you will have created an Identity feed.

To create an identity feed:

1. Add a destination for the feed.
Q
a. Goto (Admin) > Services and in the Services.

b. In the list of services, select a Log Collector service, and select ﬁ' ~ View > Config.

Select the Event Destinations tab.

d. In the Select Event Destinations field, select Identity Feed.

-+ Change Service . : Config

General Remote Collectors Files AUt i3 Event Destinations Settings

SEIEE: R ‘ Identity Feed w
Destinations

| Log Decoder
Identity Feed  identity Feed

+
e. Click and enter a unique name for the feed.
The Queue name identifies the feed within the Log Collector. Use the name of the feed for the
Queue.
Add Identity Feed
Name * infonetd_domain
Queue |inf0netd_domain| |
Rollover Interval 3
Update Interval 1

Event Source Filter

Start Processor On It
Service Startup

Cancel OK

f. Click OK.

2. Test generation of messages.

a. Have users log into Windows boxes on the domain to generate the appropriate log messages on
the domain controllers for testing.
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b. Verify that data is written to the feed files. SSH to the Log Decoder/Collector or Virtual Log
Collector being configured. Navigate to
/var/netwitness/logcollector/runtime/identity-feed and verify that the
Identity deploy files are getting populated with data.

[root@tps-reports identity-feed]# pwd
/var/netwitness/logcollector/runtime/identity-feed
[root@tps-reports identity-feed]# 1s -lah

total 20K

drwxr-xr-x. root root 109 Nov & 18:06 .

2
drwxr-xr-x. 8 root root 4 0K Nov 12 23:14
1

=MWN=F==r==, root root 106 Nov 13 15:24 identity.deploy.csv

. 1 root root| 408 Npv 13 15:24 identity_deploy.feed
-Mw=-r--r--, 1 root root _S9al Nov B 09:00 identity_deploy.xml
-rw-r--r--. 1 root root | 158 llov 13 15:17 identitycache.csv
[root@tps-reports identity-feed]# |

c. Open up a web browser (Non-Internet Explorer browsers preferred) and log in to the REST
interface of the Log Collector. Use administrative credentials when logging in. For example, if
the IP address of your Log Collector is 192.168.99.66, the URL would be:

e SSL not enabled: http://192.168.99.66:50101/event-processors
e SSL enabled: https://192.168.99.66:50101/event-processors

The browser screen should look like this:

|80 0o Response "3
lal> | |2] [+ O 192.168.99.66:5010 < | O]
[I] &5 RSA ™ Wikiand eRoom ¥ RSALink~™ SA~Y Personal ¥ r':

™)

]

The screen contains the name of the identity feed you created earlier (infonetd domain, in this
example).

For the identity feed to function correctly, port 50101 must be active on the Log Collector, and
you must determine whether SSL encryption is active.
2 :
d. Goto (Admin) > Services > <Log Collector being setup> ?‘} > View > Explore.

e. In the left pane, expand rest > config.
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& Change Service | endpointloghybrid

Z endpointloghybrid - L...

H kgl endpointloghybrid - Log Collector (LOG_C...
B[] connections
B[ deviczappliance
B[] eventbroker

B[ Jeventprocessors

-Log Collector |  Explore &

frest/config

allow.missing.user.agent true
allow.websockets false
enabled 1
port 50101
5 off

user.agent.whitelist

B[ Jlegeollection

B[ Jlegs

B rest
[Jeonfig
[ stats

B[ ]sdk

endpointloghybrid - Log Collector

g Co

For REST to be active, enabled must be set to 1.

f. Note the value for ssl. If SSL should be enabled for your environment, this must be set to on.

Collector service before moving forward.

Note: If you changed the setting for either the enabled or ssl option you must restart the Log

3. Goto (Configure) > Custom Feeds.
The Feeds dialog is displayed.

NETWITNESS

NCIDENT RULES

NCIDENT NOTIFICATIONS

MORE v

+ \
Name Trigger Disk Usage Created Last Run Time Status
TEST Once 2019-07-13 13:30:36 Completed
TEST2 Once - 2 7-13 13:50:33 Completed
te Once 16:51 Completed
onlydom Once 37 Completed
PCAP Once 2019-07-14 09:30:49 Completed

Progress
————
]

]

4. In the toolbar, click +
The Setup Feed dialog is displayed.

Setup Feed

Custom Feed

(@) |dentity Feed

Cancel

5. Make sure Identity Feed is selected and click Next.
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The Configure Identity Feed panel opens with the Define Feed tab displayed.

6. (Conditional) You can create an on-demand or recurring feed.

¢ To define an on-demand Identity feed task that executes once, select Adhoc in the Feed Task
Type field, type the feed Name, and browse for and open the feed.

o To define a recurring Identity Feed task that executes on a recurring basis, select Recurring in the

Feed Task Type field.

The Define Feed dialog includes the fields for a recurring feed.

Configure Identity Feed

Select Services Review

Define Feed

Feed Task Type Adhoc @® Recurring

Name *

[ Authenticated  User Name admin Password esessssses

[ Use proxy
Recur Every 5 & Minute(s)

Date Range

Start Date 2015-12-1419:10:25 (i End Date  2025-12-1413:11:27

Reset Cancel

URL * >r name]?msg=getfile&force-content-type=application/octet-stream&expiry=600 || Verify

Note: NetWitness verifies the location where the file is stored, so that NetWitness can check for
the latest file automatically before each recurrence.

7. Enter a value and verify the URL field.

a. In the URL field, enter the URL where the feed data file is located. This is the REST API
interface that was setup earlier. Make sure you have the following information to construct the

URL:

e The IP address of the Log Collector being used to construct the Identity Feed file.

¢ The identity queue name, as set in step 2c.

e Whether or not SSL is enabled on the Log Collector REST port, as set in step 2f.

You can construct this value as follows:

e SSL enabled: https://<LogCollector>:50101/event-processors/<ID Event
processor name>?mnsg=getFile&force-content-type=application/octet-

stream&expiry=600

e SSL not enabled: http://<LogCollector>:50101/event-processors/<ID Event
processor name>?msg=getFile&force-content-type=application/octet-

stream&expiry=600

So, using the example from earlier, the complete value that you would enter into this field is as

follows:

http://192.168.99.66:50101/event-processors/infonetd
domain?msg=getFile&force-content-type=application/octet-
stream&expiry=600?msg=getFile&force-content-type=application/octet-

stream&expiry=600
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b. For the URL verification to work correctly, it is important that the NetWitness Ul server can
access the Log Collector’s REST API port (50101). This can be tested by going to the
NetWitness Ul server via SSH. Once there, run the following command:

e SSL enabled: curl -vk https://<ip of log collector>:50101

¢ SSL not enabled: curl -v http://<ip of log collector>:50101

If the curl command does not connect then there may be a network firewall or routing issue
between the NetWitness Ul server and the Log Collector.

Example of a bad connection:

* About to connect () to 192.168.99.66 port 50105 (#0)
* Trying 192.168.99.66... No route to host

* couldn't connect to host

* Closing connection #0

curl: (7) couldn't connect to host

Example of a good connection:

About to connect() to 192.168.99.66 port 50105 (#0)

Trying 192.168.99.66... connected

Connected to 192.168.99.66 (192.168.99.66) port 50105 (#0)

GET / HTTP/1.1

User-Agent: curl/7.19.7 (x86 64-redhat-linux-gnu) libcurl/7.19.7
SS/3.19.1 Basic ECC zlib/1.2.3 1libidn/1.18 libssh2/1.4.2

Host: 192.168.99.66:50105

Accept: */*

*
*
*
>
>
N
>
>
>
< HTTP/1.1 401 Unauthorized

< Content-Length: 71

< Connection: Keep-Alive

< Pragma: no-cache

< Expires: -1

< Cache-Control: no-cache, no-store, must-revalidate
< WWW-Authenticate: Basic realm="NetWitness"

< Content-Type: text/xml; charset=utf-8

<

<?xml version="1.0" encoding="utf-8"?>

<error>401 Unauthorized</error>

* Connection #0 to host 192.168.99.66 left intact
* Closing connection #0

8. The REST API requires a username and password when attempting to pull the identity

deploy.csv file from the Log Collector. This can be any username and password that is available
on the service itself. For more information, see the "Services Security View" topic in the Hosts and

Services Guide.

Q
To see which accounts are available, go to (Admin) > Services > <log collector being setup>

> Actions > View > Security.

Under the Users table, you see all the users that can be used in this step. It is suggested that a
separate user account is created specifically for this setup, and is used nowhere else in the
environment, for added security. For details, see "Add a User and Assign a Role" in the System

Security and User Management Guide. (Go to the NetWitness All Versions Documents page and find

NetWitness Platform guides to troubleshoot issues.)

9. To define the recurrence interval, do one of the following:
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10.

1.

12.

13.

14.

¢ Specify the number of minutes, hours, or days between recurrences of the feed.
¢ Enter the date range for the execution of the feed to recur, specify the Start Date and time and the
End Date and time.

If using SSL encryption, you need to install the REST API SSL certificate for the Log Collector into
the NetWitness Ul server. For more information, see Import the SSL Certificate.

If, after importing the SSL certificate, the verification of the URL still fails, see Cannot Verify
Identity Feed URL.

Click Verify to verify your identity feed configuration before you proceed to the Select Services
dialog.

Click Next.

The Select Services dialog is displayed.

Configure Identity Feed

Define Feed Select Services Review

L ﬁ( Name ~ Address Type

O o | Decoder Decoder

] 55( Log Decoder Log Decoder

Reset Cancel Prev MNext

To identify services on which to deploy the feed, select one or more Decoders and Log Decoders
and click Next.

Click the Groups tab, select a group, and click Next.
The Review dialog is displayed.
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Configure Identity Feed

Define Feed Select Services
Mame Testing

zip sample.zip

Services Decoder

Cancel

Note: If a group of devices with Decoders and Log Decoders is used to create recurring or custom
feeds and this group is deleted, you can edit the feed and add a new group to the feed.

15. Anytime before you click Finish, you can:
¢ Click Cancel to close the wizard without saving your feed definition.
¢ Click Reset to clear the data in the wizard.
¢ Click Next to display the next form (if not viewing the last form).
¢ Click Prev to display the previous form (if not viewing the first form).

16. Review the feed information, and if correct, click Finish.

Upon successful creation of the feed definition file, the Create Feed wizard closes, and the feed and
corresponding token file are listed in the Feed grid and progress bar tracks completion. You can expand
or collapse the entry to see how many services are included, and which services were successful.

NETWITNESS

LIVE CONTENT SUBSCRIPTIONS

Feeds

+
Name Trigger Feed Size Created Last Run Time Status Progress
B FILEHASH Fetches STIX feeds from ZDZOrMayr' 903:16, running every S minutes 0 bytes 2020-05-19 03:25:23 2020-05-22 05:16:01 Completed S
& FILESTIX Fetches STIX feeds from 2020-May-19 03:32, running every 5 minutes 0 bytes 2020-05-19 03:32:09 2020-05-22 05:12:09 Completed ——
B AllindicatorsREST Fetches STIX feeds from 2020-May-19 04:48, running every 5 minutes 0 bytes 2020-05-19 05:03:52 2020-0! 5:13:26 Completed D
B AlLUIndEdited Fetches STIX feeds from 2020-May-19 05:13, running every 5 minutes 0 bytes 2020-05-19 05:13:54 2020-05-22 05:13:54 Completed ]
B TAXlIServer1 Fetches STIX feeds from 2020-May-19 05:44, running every 5 minutes 288 bytes 2020-05-19 05:44:38 2020-05-22 05:14:38 Completed ]
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Import the SSL Certificate

If SSL is configured on the Identity feed’s Log Collector, follow these steps to import the Log
Collector’s SSL certificate into the NetWitness Ul server key store. If this certificate is not imported, the
NetWitness Ul server will be unable to pull the Identify feed file from the Log Collector.

1. To pull the SSL certificate off the Log Collector, SSH into the NetWitness Ul server and run the
following command:

echo -n | openssl s client -connect <HOST>:<PORT> | sed -ne '/-BEGIN
CERTIFICATE-/,/-END CERTIFICATE-/p' > /tmp/<SERVERNAME>.cert

This command saves the SSL certificate to / tmp/<SERVERNAME>. cert. For example:

echo -n | openssl s client -connect 192.168.99.66:50101 | sed -ne '/-BEGIN
CERTIFICATE-/,/-END CERTIFICATE-/p' > /tmp/logcollector.cert

2. To import the SSL certificate into the NetWitness Ul server, SSH into the UI server and run the
following command:

keytool -importcert -alias <name an alias for the cert> -file <the cert
file pathname> -keystore /etc/pki/java/cacerts

For example:

keytool -importcert -alias logcollector0l -file /tmp/logcollector.cert -
keystore /etc/pki/java/cacerts

3. The system requests a password. Enter the password for the keystore on the NetWitness Ul server,
not for the jetty keystore. The default password is changeit.

4. Restart jettysrv to allow jetty to read the new certificate in the store.
Cannot Verify Identity Feed URL

If the Identity feed URL cannot be verified, and you are using SSL, make sure you followed the steps in
Import the SSL Certificate.

If there are issues, it is possible that the internal name of the certificate does not match the hostname of
the Log Collector. The following procedure checks this.

1. SSH to the NetWitness UI server.
2. Run the following command to output the CN name of the SSL cert:

echo -n | openssl s client -connect <log decoder>:50101 sed -ne '/BEGIN

CERTIFICATE-/, /—END_CERTIFICATE—/p'

For example:

echo -n | openssl s client -connect salogdecoder01:50101 | sed -ne '/BEGIN
CERTIFICATE-/,/-END CERTIFICATE-/p'

3. Retrieve the CN name of the SSL certificate.
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4. Edit the /etc/hosts file and add the IP address and CN name to the file.

5. Restart the network service on the appliance.

6. Confirm that the name placed in the /etc/hosts file is used instead of the FQDN or IP address in the
Identity feed URL.

7. Re-verify the Identity feed URL.

Investigating an Identity Feed

An identity feed tracks interactive log on events from the Windows operating system. Identity feeds do
not track interactive log off events.

In order for an identity feed to process events and tag them, the events need to be collected using
a Windows Log Collection module where an Active Domain Controller or non-Domain Controller is
configured. Note that identity feeds can only be processed via an Identity Feed Event Processor.

Note: An identity feed only tracks one log in at a time. If two users log in to a system at the same
time, the second user will overwrite the first user's data in the identity feed.

Once you have created an identity feed, you can view the results by investigating the feed.

To investigate a configured identity feed:
1. Go to INVESTIGATE > Navigate.

If no default service is selected, the Investigate dialog is displayed.

Investigate

Services Collections

M Default Service

MName ~ Address Type

Eroker 10.31.125.243 Eroker
Broker 10.31.125.245 Broker
Broker 10.31.125.240 Broker
Cancentrater (Default) 10.31.125.244 Cancentratcr
Decoder 10.31.125.243 Decoder

Log Decoder 10.31.125.246 Log Decoder

Cancel Navigate
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2. Select a service, usually a Concentrator, and click Navigate.
3. Select Load Values to retrieve meta data.
In the Values panel, scroll down to find the Meta Keys:

NETWITNESS

ACY EVENTS VENTS MALWARE ANALYSIS

B endpointloghybrid - Concentrator ¥ Query ® Elprofile ® EIMeta @ | "B Total ©® .= Descending © E5EventCount ® | SaveEvents ® -~ Actions @

2012 | 3§ | 15:35:00 (+00:00) All Data 2017 | 53 | 14:50:59 (+00:00)

dnyoo xa1u0)

¥ Options A Hide

Decoder Source (2 values) 2
nwappliance23912 (100,000 - 5%) - nwappliance11639 (182)

Alerts es) /

6,458) - tele test (5,773) - address : 161.253.11.233 (4,948) - ip alert for 29.1 (3,581) - sky
4) - ipv4 vertical udp port scan 5(210) - ipv4 bulk data transfer 20 mb (76) - ipsrc test 176 (37)

) - ipv4 horizontal port scan
ipv4 vertical tcp port scan 5 (2,

test dom (>1 5 w match (>100.
test (3,095) potential web sweep 10(
-ipv4 bulk data transfer 50 mb (17)

o]

2

Risk: Informational

http1.1 without referer header (67,513) - unknown service over http port (51,581

- unknown service over smtp port ( - http1.1 without server header (39,937) - http1.0
unsupported cache header ( http1.0 unsupported cor on header 16) - http1.0 unsupported host header (21,538) - http1.1 server location redirect (21,090
ack flag in session (18,655) - unknown service over ssl port (15 - http1.0 without server header (12,163) - http over non-standard port (11, - http1.1 without ac

headar (11 122\ . httn1 1 hich headar raunt (10 GA2) . httn1 O withaut rafarer headar (7 S0R) . httn1 0 inciinnarted atac header (6 QA7) . httn1 1 withant cannactinn

The identity feed provides information to selected Decoders and Log Decoders. It associates the Host IP
data from the Windows operating system to the user logging into that Host in order to tag all logs
associated with that IP and investigate.
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Editing a Feed

This topic provides instructions for editing a custom feed using the Custom Feed Wizard.

After you edit a feed:

e The feed (.zip format) or the file used to create the feed (.csv or .xml) has been downloaded and
edited.

e The feed has been recreated with the updated file and new feed specifications.
To edit an existing feed:

1. Goto (Configure) > CUSTOM FEEDS.
The Custom Feeds dialog is displayed.

NETWITNESS

+ |
Name Trigger Disk Usage Created Last Run Time Status Progress
o TEST Once 2019-07-131 2019-07-13 13:30:36  Completed —
o TEST2 Once Completed ——
o te Once Completed ——
& onlydom Once Completed ———
o PCAP Once Completed ———

4

2. In the toolbar, select a feed and click =,

The Configure Custom Feed or Configure Identity Feed panel opens in the Custom Feed wizard.

Configure a Custom Feed

Define Feed Select Services Define Columns Review

Feed Type 5 & STIX
Feed Task Type '# AChoC Recurring
M arme * TEST

File Feed

- -t 0 Browse

Reset Cancel MNext
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3. If you want to edit the feed file:
a. Click download file.

For an Identity feed, the .zip file is downloaded. For a custom feed, the .csv or .xml file is
downloaded to your local file system.

b. Edit and save the file.
c. In the Define Feed tab, browse for and open the edited file.

4. Edit any other parameters in the Define Feed tab, Select Services tab, and Define Columns tab that
apply to the type of feed.

5. Anytime before you click Finish, you can:

¢ Click Cancel to close the wizard without saving your changes.

¢ Click Reset to clear the data in the wizard.

¢ Click Next to display the next form (if not viewing the last form).

¢ Click Prev to display the previous dialog (if not viewing the first form).
6. In the Review tab, review the feed information, and if correct, click Finish.

The feed is added to the feeds list and progress bar tracks completion. Upon successful creation of the
feed definition file, the Create Feed wizard closes, and the feed and corresponding token file is listed in
the Feeds list. You can expand or collapse the entry to see how many services are included, and which
services are successful.
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Removing a Feed

This topic provides instructions for removing a feed. You might want to remove a feed when some or all
of the information in the feed is no longer useful for your organization.

To remove a feed:

1. Goto (Configure) > CUSTOM FEEDS.
The Custom Feeds dialog is displayed.

NETWITNESS

NCIDENT NOTIFICATIONS

+ \
Name Trigger Disk Usage Created Last Run Time Status Progress
o TEST Once Completed —
o TEST Onc Completed —
o te Onc: Completed —
B onlydom Onc 2019-07-14 04:21:37  2019-07-1404:21:37  Completed —
P Onc 2019-07-1409:30:49  2019-07-14 09:30:49  Completed —

2. In the toolbar, select a feed and click ~— .

The Delete Custom Feeds dialog is displayed.

Delete Custom Feeds

Local DB and Service

® Local DB Only

Service Only

Cancel Delete

You can select one of the following options to delete the feed:

¢ If you choose to delete the feed from Local DB and Service, the feed is deleted from both
the service and the local NetWitness box. The deleted feed will no longer seen on
the NetWitness user interface.

¢ If you choose to delete the feed from Local DB Only, the feed is deleted from the local
NetWitness box. The deleted feed will not be seen on the NetWitness user interface; however, the
last deployed version of the feeds will be present on the service. The undeployed feeds will be
deleted forever.

o If you choose to delete the feed from Service Only, the feed is deleted from the service. The
deleted feed will appear on the NetWitness user interface and can be deployed again
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3. Select which feed you want to delete and click Delete.
A warning dialog is displayed.

4. Click yes to confirm that you want to delete the feed from the selected areas.

Delete Custom Feeds

Service Status Progress

Decoder FAILURE
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Subscribing to Live Resources

This section describes subscriptions in Live.

Threats and the corporate landscape change over time. NetWitness periodically reviews existing content
to determine whether it needs to be updated based upon current campaigns, or has become irrelevant due
to changes in technology or attack techniques and tools.

You can discover new content by using the What’s New dashlet within the Default Dashboard, or by
searching through NetWitness Live by data range since last deployed. Be sure to subscribe to any content
for which you want to receive update notifications.

Subscription Updates

When you view resources in the Matching Resources panel of the Live Content view, there is a column
named Updated:

Matching Resources

= Show Resuls | | % Package
Subscribed | Name Created Updated Type Description
no Advanced Windows Execut..  2012-02-09 4:50 PM 2014-03-20 3:53 PM FlexParser Legacy: Intenc
no Fingerprint Windows M5l 2012-02-09 451 FM 2012-02-09 451 FM FlexParser Legacy: Intenc
no Microsoft Windows 2018-03-27 146 PM 2018-03-27 147 PM Log Device Log device cor
yes windows_executable 2013-10-18 1:53 PM 2007-11-13 22535 PM Lua Farser dentifies winc
no Windows Command Shell 2012-02-09 451 FM 2013-08-27 708 AM FlexParser Legacy: Intenc
yes Lateral Movernent Indicato...  2018-03-09 12:54 AM 2018-07-31 759 PM Met\Witness Report Report display
yes windows_command_shell_|.. 2013-10-18 1:55 PM 2016-11-14 6:40 FM Lua Parser dentifies Micr
yes Windows Credential Harves...  2016-03-09 12:54 AM 2016-03-09 12:54 AM NerwWitness Rule This rule moni
L] Windows Process Parent C...  2018-03-11 734 P 2018-053-11 7:34 PM MetWitness Rule There are sets
yes Windows NTLM Network Lo...  2016-03-08 12:54 AM 2015-03-059 12:54 AM NetWitness Rule ndicares a po
no Autoruns and 5cheduled Ta...  2018-05-11 7:33 PM 2018-05-11 7-33 FM NerwWitness Rule Attackers will
no Windows Events (ER) 2014-02-14 3:34 AM 201 8-03-27 8:30 AM Log Device Log device cor
no Windows Events (NIC) 2014-02-14 3:55 AM 2018-09-03 1211 PM Lag Device Log device cor

_ L4
66 Matching Resources

This value is also displayed when you select the detailed view for a resource. Every time a resource
changes, its Updated value changes to match the specific update. If you are subscribed to a resource, and
it gets updated, your system is automatically updated with the latest version, and you receive a

notification. You can view your notifications by clicking the Notification icon, ==, from anywhere in
the NetWitness UL
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NETWITNESS @ Home B Investigate (JRespond S Users CdHosts [EFiles BfDashboard [E Reports = admin v
Notifications
LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES ESA RULES CUSTOM FEEDS INCIDENT RULES I <., ice added

Search Criteria Matching Resources Entitlement Expiration

Keywords = Show Results © | ¥ Package

Entitl t E irati
Certain services are managed by Centralized Content Management(CCM). To manage content on those { 5™*'!€™ €Nt Expiration

Category Subscribed Name Created Updated
D FEATURED [ no LDAP 2013-09-12 2:21 PM 2023-12-22 11:42 AM , and extensions. Only LDAP sessiol,
» CITHREAT no RSA SecurlD-Bad Token Co...  2017-02-27 3:07 PM 2017-09-23 5:48 AM NetWitness Rule Returns usernames that have failed to authenticate as declared by RSA S
4 IDENTITY no RSA SecurlD Cloud Top Fail. 2019-04-17 6:19 AM 2019-04-17 6:23 AM NetWitness Rule The report rule fetches the top 10 failed user events. VERSIONS SUPPOR
i Authentication no SecurlD Cloud Device Regis... ~ 2019-04-17 5:54 AM 2019-04-17 5:56 AM Application Rule Raises an alert when RSA SecurlD (Cloud) device registration succeeds. V
i Authorization no Remote Password Cracking...  2024-04-08 9:29 AM 2024-04-08 9:29 AM NetWitness Argus ... Detects login failures from an IP address or host source to 3 different IP ¢
Accounting [ no Logon Failures Summary 2013-03-27 6:55 PM 2017-09-23 5:48 AM NetWitness Rule Displays the top logon failures as populated by log event traffic.
» CJASSURANCE no Multiple Service Connectio...  2024-04-08 9:10 AM 2024-04-08 9:10 AM NetWitness Argus ... Detects 4 failed login attempts from the same source to the same destin.
N m OPERATIONS [ no QQ_lua 2013-11-1512:44 PM 2017-09-23 5:37 AM Lua Parser Identifies QQ (OICQ protocol) sessions. Extracts number QQ user id, and
[CspEcTRUM no SecurlD Cloud LDAP Auth F...  2019-04-17 5:54 AM 2019-04-17 5:57 AM Application Rule Raises an alert when RSA SecurlD (Cloud) user LDAP authentication fails.
I MALWARE ANALYSIS no SecurlD Cloud Audit Log Co...  2019-04-17 5:53 AM 2019-04-17 5:56 AM Application Rule Raises an alert when RSA SecurlD (Cloud) admin audit log configuration i
O no Logon Success Summary 2016-08-29 6:48 PM 2017-09-23 5:48 AM NetWitness Rule Displays the top logon success as populated by log event traffic
Resource Types no Remote Data Harvesting 2024-04-08 9:13 AM 2024-04-08 9:13 AM NetWitness Argus ...  Detects a successful Juniper web-based SSL VPN login followed by the trz
v [ no IAM - Multiple worldwide s... 2021-09-14 6:54 AM 2021-09-14 6:54 AM Event Stream Anal...  This rule triggers when there are specified number of successful console
Medium no RSA SecurlD Cloud Top Fail.. ~ 2019-04-17 6:19 AM 2019-04-17 6:23 AM NetWitness Rule The report rule fetches the top 10 IP addresses of failed user events. VER
- no SecurlD Cloud APl Keys Ad... ~ 2019-04-17 5:53 AM 2019-04-17 5:56 AM Application Rule Raises an alert when RSA SecurlD (Cloud) Access admin API keys are addh

»
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You can also get email notifications when subscribed resources are updated. System Administrators can

Q
add email addresses in the (Admin) > SYSTEM > Live Services view. For more information, see
the "Live Services Configuration Panel" topic in the System Configuration Guide.

Adding Subscribed Resources for Deployment to Services

1. Goto . (Configure) > Subscriptions > Deployments.

2. In the Groups panel, select a group.
Subscribed resources, if any, are listed in the Deployments tab Subscriptions panel.

3. In the Subscriptions panel, click +
The Add Subscription dialog, which lists subscriptions available for deployment, is displayed.

4. Select the subscribed resources that you want to deploy to the services group.
Click Save.

The dialog closes and the subscriptions are added to the listing in the Deployments tab, Subscriptions
panel. This stages the resources for deployment at the next synchronization.

6. You can click the Synchronize icon, ™ , to immediately synchronize your changes.

]

Deleting a Subscription

When you delete a subscription to a resource, deployed instances of the resource are not deleted. The
deployed resource remains on services until explicitly removed, but the resource is no longer
synchronized with the resource in NetWitness Live.

To delete a subscription:

1. Goto - (Configure) > Subscriptions.

2. In the Subscriptions tab, select the subscriptions you want to delete.
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3. Click ~ , then choose Delete to delete your selected resources or Delete All delete all subscriptions.
A dialog asks for confirmation that you want to delete the subscription.

4. To confirm removal, click Yes.
Your selected subscriptions are deleted from the subscriptions list, but any deployed instances of the

subscribed resource remain on the services.

Removing Subscribed Resources from the Deployments Subscriptions Grid

Subscriptions that are selected for deployment to a service group are deployed during synchronization.

You can remove subscriptions from the Live (Configure) > Subscriptions > Deployments panel, but
any that have actually been deployed to services remain deployed until someone removes them.

To remove resources from the Deployments tab Subscriptions panel:

1. Goto (Configure) > Subscriptions > Deployments
2. In the Groups panel, select a group.

Subscribed resources, if any, are listed in the Subscriptions panel.
3. In the Subscriptions panel, click —.

A dialog requests confirmation that you want to delete the resource from the service group. The
resource is removed from the Deployments tab Subscriptions panel, but is not removed from services
on which it is deployed.

Subscribe and Unsubscribe to a Resource

When you subscribe to resources, you will receive notification when new versions of the resources are
available.

To subscribe to a resource:

1. Goto (Configure) > Live Content.

2. In the Search Criteria panel, specify search criteria and click Search.

3. Select one or more resources and click = Subscribe

A confirmation dialog is displayed: By subscribing to these resources, you are indicating that you
wish to receive notification when new versions are available.

4. To confirm that you want to subscribe to the resource, click OK.

The resource is added to the subscriptions managed in the Subscriptions tab and is available for
deployment in the Deployments tab.

When unsubscribing from a resource, you have the option to leave the resource on services on which it is
deployed or to remove it from services.
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To unsubscribe from a resource:

1. Open a detailed view of a resource in one of the following ways:

Perform a search, (Configure) > Live Content > enter search criteria, then select the
resource in the Matching Resources panel, then click =/ Details

View subscriptions, (Configure) > Subscriptions, select the resource from the Subscriptions
list, then click =] Details

NETWITNESS e &

CAPTURE POLICIES POLICIES ESA RULES CUSTOM FEEDS INCIDENT RULES INCIDENT NOTIFICATIONS

. Download A\ Subscribe B, Deploy

AWS Security Hub Log Collector Configuration

Log Collector

2020-07-28 6:17 PM

2020-07-29 7:52 AM

Log Collector configuration content for event source AWS Security Hub

1.2

2. With the detailed view of a resource displayed. click *% Lnsukscrie .

A confirmation dialog is displayed.

Unsubscribe Resource?

You will no longer be notified of new updates to this
resource.

Resource will still be installed unless you manually remove it.

Cancel Unsubscribe Unsubscribe and Remove

3. Do one of the following:

¢ To confirm that you want to unsubscribe from the resource and leave it on the services where it is
deployed, click Unsubscribe.

¢ To confirm that you want to unsubscribe from the resource and remove it from the services where
it is deployed, click Unsubscribe and Remove from Services.

¢ To close the dialog without unsubscribing, click Cancel.

The selected action is applied.

Viewing Subscribed Resources Selected to Deploy on Services

In the (Configure) > Subscriptions > Deployments tab you can view subscribed resources that
have been selected for deployment on services.
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To view subscribed resources that have been selected for deployment on services:

In the Groups panel, select a group, and expand it to view services in the group. The resource
subscriptions selected for deployment are listed in the Deployments tab Subscriptions panel.
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Miscellaneous Live Services Procedures

This section describes several other procedures.

Displaying Resource Details in Live Resource View

After you select a resource (in the Live Resource View), you can view its detailed information.

To open a separate tab in the Live Resource view with details of a selected resource, do one of the

following:

o If you are viewing the results in Show Results > Detailed view, click the resource type icon or the

resource name.

NETWITNESS

LIVE CONTENT

Search Criteria

Keywords

Category
[ FEATURED
» CJTHREAT
» CJIDENTITY
» [CJASSURANCE
» [ OPERATIONS
[JspecTRUM

[ MALWARE ANALYSIS

Resource Types

Malware Rules @  Log Collector @

Medium

Required Meta Keys

CAPTURE POLICIES

POLICIES CUSTOM FEEDS NCIDENT NOTIFICATIONS

Matching Resources

[ Show Results ~ | | 3 Package
=s¢' RSA Malware PE Artifacts
Malware Rules 2018-05-0411:11 PM 0.2 74.5KB no
Yara I0Cs which statically analyze Windows PE file artifacts for signs of malware.
=s¢' RSA Malware PE Packers
Malware Rules 2013-11-21 9:07 PM 0.1 93.97 KB no
Yara I0Cs which statically analyze Windows PE files to identify Common Packers
=s¢' RSA Malware PDF Artifacts
Malware Rules 2013-11-21 9:07 PM 0.1 587 B no
Yara I0Cs which statically analyze PDF file artifacts for signs of malware
McKesson HPF Log Collector Configuration
Log Collector 2017-09-13 5:09 PM 0.2 1.42 KB no
Log Collector configuration content for event source McKesson HPF
@ event analysis, operations, log analysis
SAP ERP Central Component Log Collector Configuration
Log Collector 2017-09-13 5:10 PM 0.2 1.24 KB no

Log Collector configuration content for event source SAP ERP Central Component
™ avant analucic
191 Matching Resources

Anaratinne lna anakucic

o If you are viewing the results in Show Results > Grid view, double-click a resource or select a
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Downloading a Resource

resource and click Details.

NETWITNESS

Search Criteria

Keywords

Category
[ FEATURED
» [ THREAT
» CJIDENTITY
» [JASSURANCE
» [ OPERATIONS
[ISPECTRUM

[CIMALWARE ANALYSIS

Resource Types

Medium

Required Meta Keys

Generated Meta Values

Resource Created Date:

Start Date

Resource Modified Date:

End Date

CUSTOM FEEDS

how Results = |

INCIDENT RU

NCIDENT NOTIFICATI

¥ Package

Certain services are managed by Centralized Content Management(CCM). To manage content on those services, click he

Subscribed Name

Injecting Web Shell to Cold

Endpoint Pack

Host Traffic to External IP C...
Runs Powershell Command...
Possible Port Scanning Det...

Possible SMB Scanning Det..

Packet Starter Pack
Known Threats Pack
0365 - Mass SharePoint Fil,
EC2 - Multiple instances ter,

11.3 Rarest Code Signing C

Confluence Web Shell Activi...

11.3 Autoruns and Schedul.

GCP - Multiple vm instance...

suspicious sdiagnhost.exe

11.3 Endpoint Indicators by...

NetWitness Administration ...

Potential APT Service Install
Outbound BazarLoader DN

Modifies Windows Security

394 Matching Resources

Created

2022-10-27 12:29 PM
2019-04-10 3:45 PM
2022-06-08 6:53 PM
2022-10-18 6:28 AM
2022-09-15 3:56 PM
2022-09-15 3:54 PM
2016-12-30 5:53 PM
2017-06-06 4:28 PM
2022-12-07 2:28 PM
2021-09-14 6:55 AM
2019-04-10 1:52 PM
2022-10-27 11:52 AM
2019-04-10 1:51 PM
2022-02-04 11:47 AM
2022-07-20 6:10 PM
2019-04-10 1:51 PM
2018-07-18 9:20 PM
2015-07-02 7:11 AM
2022-01-28 2:50 PM

2022-10-18 6:21 AM

Updated
2022-11-29 3:47 PM
2023-03-08 3:22 PM
2023-08-31 6:34 AM
2022-11-29 5:39 PM
2023-06-15 2:57 PM
2023-06-15 2:57 PM
2023-01-19 4:04 PM
2023-01-19 3:47 PM
20221221 6:11 PM
2021-09-14 6:55 AM
2019-04-10 2:02 PM
2022-10-27 11:52 AM
2019-04-10 2:02 PM
20220204 11:47 AM
2022-10-27 7:25 AM
2019-04-10 2:02 PM
2018-07-18 9:23 PM
2017-09-23 5:36 AM
2022-01-28 2:50 PM

2022-10-18 6:21 AM

You can download a single resource from the Live Resource View.

To download a resource:

1.

Go to

(Configure) > Live Content.

Type

Application Rule
Bundle
Application Rule
Application Rule
Application Rule
Application Rule
Bundle

Bundle

Event Stream Anal
Event Stream Anal
NetWitness Rule
Application Rule

NetWitness Rule

Event Stream Anal...

Application Rule
NetWitness Rule

NetWitness Rule

Event Stream Anal...

Application Rule

Application Rule

Description
Identifies shell processes such as ‘cmd.exe' or powerst
Deploying this bundle will download all of the content
Many malwares, once successfully compromising a ho
Running remote powershell command can be an indic
Adversaries may execute active reconnaissance scans
Adversaries may execute active reconnaissance scans
This pack contains a set of starter content specific to p
This pack contains a set of content specific to known ic
This rule triggers when the specified number of Sharef
This rule triggers when specified number of EC2 instar
Details of Child Processes of web server. Web Shells cz
Identifies shell processes such as ‘tmd.exe' or Powerst
Attackers will often use registry autoruns and schedule
This rule triggers when the specified number of VM ins
This rule alerts on Scripted Diagnostics Native Host cre
Number of risk indicators associated with each host br
This Rule gives a summary of event types and sub type
10.4 or higher. Detects a host making a connection to
BazarLoader (Also known as Baza, BazaLoader) is a file

This rule detects a Non-Microsoft binary modifying sec |

»

2. In the Search Criteria panel, enter the criteria needed to return the resource you want to download.

3. Select a single resource, then click =/ Details

4. Click % Download

The resource is saved as a ZIP archive to your local Downloads folder.

Locating and Removing a Deployed Resource from Services

You can locate and remove a deployed resource from services from the Live Resource View.

To view a list of services on which a resource is deployed:

1. With a resource displayed in the Resource View, click EE. Service Locator -

The Service Locator dialog is displayed.
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Service Locator

= Remo

Services
O ,6{ Name ~
O n

Type

ppliance19848 - Log Decoder Log Decoder

Cancel

2. Select one or more services in the Services list.
3. Click =.

The resource is removed from the selected services.

Showing Results as a List or in Detail

1. Select Show Results > Grid to change to grid results when viewing detailed results.

NETWITNESS

CUSTOM FEEDS

Search Criteria Matching Resources

Keywords Show Results ~ | | % Package
Certain services are managed by Centralized Content Management(CCM). To manage content on those services, click here
Category Subscribed  Name Created Updated Type
[CIFEATURED no Injecting Web Shell to Cold... ~ 2022-10-27 12:29 PM 2022-11-29 3:47 PM Application Rule
» (I THREAT no Endpoint Pack 2019-04-10 3:45 PM 2023-03-08 3:22 PM Bundle
» CJiDeNTITY no Host Traffic to External IP C...  2022-06-08 6:53 PM 2023-08-31 6:34 AM Application Rule
» CIASSURANCE no Runs Powershell Command... ~2022-10-18 6:28 AM 2022-11-29 5:39 PM Application Rule
» CJOPERATIONS no Possible Port Scanning Det... ~ 2022-09-15 3:56 PM 2023-06-15 2:57 PM Application Rule
[CISPECTRUM no Possible SMB Scanning Det...  2022-09-15 3:54 PM 2023-06-15 2:57 PM Application Rule
] MALWARE ANALYSIS no Packet Starter Pack 2016-12-30 5:53 PM 2023-01-19 4:04 PM Bundle
Resource Types no Known Threats Pack 2017-06-06 4:28 PM 2023-01-19 3:47 PM Bundle
. no 0365 - Mass SharePoint Fil... ~ 2022-12-07 2:28 PM 20221221 6:11 PM Event Stream Anal...
no EC2- Multiple instances ter... ~ 2021-09-14 6:55 AM 2021-09-14 6:55 AM Event Stream Anal.
Medium no 11.3 Rarest Code Signing C. 2019-04-10 1:52 PM 2019-04-10 2:02 PM NetWitness Rule

no Confluence Web Shell Activi... 2022-10-27 11:52 AM

no 11.3 Autoruns and Schedul... ~ 2019-04-10 1:51 PM
Required Meta Keys

no GCP - Multiple vm instance... ~ 2022-02-04 11:47 AM

no Suspicious sdiagnhost.exe 2022-07-20 6:10 PM
Generated Meta Values

no 11.3 Endpoint Indicators by...  2019-04-10 1:51 PM

no NetWitness Administration 2018-07-18 9:20 PM
Resource Created Date:

no Potential APT Service Install  2015-07-02 7:11 AM
Start Date End Date

no Outbound BazarLoader DN... ~ 2022-01-28 2:50 PM

Resource Modified Date:

Modifies Windows Security 2022-10-18 6:21 AM

394 Matching Resources

2022-10-27 11:52 AM
2019-04-10 2:02 PM
2022-02-04 11:47 AM
2022-10-27 7:25 AM
2019-04-10 2:02 PM
2018-07-18 9:23 PM
2017-09-23 5:36 AM
2022-01-28 2:50 PM

2022-10-18 6:21 AM

Application Rule

NetWitness Rule

Event Stream Anal...

Application Rule
NetWitness Rule

NetWitness Rule

Event Stream Anal...

Application Rule

Application Rule

Description
Identifies shell processes such as ‘cmd.exe' or powerst
Deploying this bundle will download all of the content
Many malwares, once successfully compromising a ho
Running remote powershell command can be an indic
Adversaries may execute active reconnaissance scans
Adversaries may execute active reconnaissance scans
This pack contains a set of starter content specific to p
This pack contains a set of content specific to known ic
This rule triggers when the specified number of Sharef
This rule triggers when specified number of EC2 instar
Details of Child Processes of web server. Web Shells cz
Identifies shell processes such as ‘cmd.exe' or Powerst
Attackers will often use registry autoruns and schedul¢
This rule triggers when the specified number of VM in
This rule alerts on Scripted Diagnostics Native Host cre
Number of risk indicators associated with each host br
This Rule gives a summary of event types and sub type
10.4 or higher. Detects a host making a connection to
BazarLoader (Also known as Baza, Bazaloader) is a file

This rule detects a Non-Microsoft binary modifying sec

»
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2. Select Show Results > Detailed to change to detailed results when viewing grid results.

NETWITNESS

SCRIPT

CUSTOM FEEDS INCIDENT RULES NCIDENT NOTIFICA

Search Criteria Matching Resources
Keywords Show Results | € Package
= A Malw
Category Malware Rules 2018-05-04 11:11 PM 0.2 size 74.5 KB no
[CJFEATURED Yara 10Cs which statically analyze Windows PE file artifacts for signs of malware.
» CITHREAT
» CJIDENTITY ] o
Malware Rules 2013-11-21 9:07 PM 0.1 93.97 KB no
» CJASSURANCE
Yara 10Cs which statically analyze Windows PE files to identify Common Packers
» CJ OPERATIONS
[JsPECTRUM =g RSA Malware PDF Artifacts
[ MALWARE ANALYSIS Malware Rules 2013-11-219:07 PM 0.1 size 587 B no
Yara 10Cs which statically analyze PDF file artifacts for signs of malware
Resource Types
Malware Rules @  Log Collector @ v on HPF L “ollector Configuration
Log Collector 2017-09-13 5:09 PM 0.2 1.42 KB no
Medium Log Collector configuration content for event source McKesson HPF
v @ event analysis, operations, log analysis
Required Meta Keys SAP ERP Central Component € onfiguration
Log Collector 2017-09-13 5:10 PM 0.2 1.24 KB no
2f Log Collector configuration content for event source SAP ERP Central Component
™ cuant analucic anaratinne Ing anakeic -
191 Matching Resources

Viewing Resource Details

You can display detailed information about a subscribed resource in the Resource View.

To view details:

1. In the Subscriptions tab, select a single subscription.
Click Details

The details of the resource are displayed in the Resource View.

2.

NETWITNESS

NCIDENT NOTIFICATIONS

&, Download N\ Subscribe B, Deploy €D Service Locator

Injecting Web Shell to ColdFusion

Application Rule
2022-10-27 12:29 PM
2022-11-29 3:47 PM

Identifies shell processes such as 'cmd.exe' or powershell being
spawned by a ColdFusion process. Suspicious processes launched by
ColdFusion may indicate a compromise of the web server. Investigate
the command being run and attempt to determine their purpose. Look
for signs of further activity from a potential malicious actor, such as
host or network discovery commands being executed, as these often
precede attempts at lateral movement.

VERSIONS SUPPORTED
* NetWitness Platform 11.5 and higher

DEPENDENCIES
* NetWitness Endpoint Server
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References

This topic is a collection of references, which describe the user interface and more detailed information
about how Live works in NetWitness. These topics are presented in alphabetical order.

e Deployments Tab

¢ Discontinued Resources Tab

e Live Configure View

e Live Feeds View

e Live Resource View

e Live Search View

e Live Search Content View

e NetWitness Feedback and Data Sharing

e NetWitness Live Registration Portal

e Resource Package Deployment Wizard

* Subscriptions Tab
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Live Configure View

In the Live Configure view, NetWitness provides integrated tools for managing Live resources. You can
manage resource subscriptions, deployments to services and discontinued resources. The required role to
access this view is Configure Live Resources. For a high-level description of how to use the different
views in NetWitness Live, please read Live Services Management.

To access this view, navigate to (Configure) > Subscriptions. The view has three tabs:
Deployments Tab, Subscriptions Tab, and Discontinued Resources Tab.
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Deployments Tab

The Deployments tab provides a user interface in the Live Configure view for:
e Viewing subscribed resources that are selected for deployment on services in a service group.
» Selecting subscribed resources to deploy to services in a service group.

e Removing resources that are selected for deployment on services in a service group.

The resources listed here are not deployed immediately after adding to a service group. Instead the
subscribed resources are pushed to the services when NetWitness synchronizes with NetWitness Live.
The synchronization schedule is configured in the Live Configuration panel. Additionally, you can

synchronize immediately in the (Configure) > Subscriptions > Deployments tab.

Likewise, resources deleted from the Deployments panel are not deleted from service where they have
been deployed. To delete resources from services, delete them in the Live Resource View.

The required permission to access this view is Manage Live Resources.
To access this view:

1. Goto (Configure) > Subscriptions.
The Subscriptions tab is displayed.
2. Click the Deployments tab.

NETWITNESS

NILELELEN Deployments — Discontinued Resources

Certain services are managed by Centralized Content Management(CCM). To manage content subscription on those services, click here
Name Type Version Discontinued Updated Description

I Microsoft Azure Log Device 58.31 no 2024-06-13 5:56 AM Log device content for event source Microsoft Azure -...

[ Microsoft Windows Log Device 65.14 no 2024-08-29 12:47 PM Log device content for event source Microsoft Windo...

[ Microsoft Office 365 Log Device 47.0 no 2024-07-12 6:06 AM Log device content for event source Microsoft Office ..

The Deployments tab has two panels: Groups and Subscriptions.
Groups Panel

The Groups panel is a static display of configured service groups that were created in the Administration
Services view. Selecting a group in the Groups panel populates the Subscriptions panel with a list of
subscriptions that are selected for deployment on the services in the service group.

Description

Name Displays the service group name. Clicking the plus sign displays a nested list of services in the group.
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ran Jowmn

Address

Type

Displays the IP address of each service in the group.

Displays the type of service.

Subscriptions Panel

The following table describes the features in the Subscriptions panel.

P omerpion

Click + to open a dialog that lists subscriptions that were added in the Live Search view or in the
Live Resource view and are available for deployment.

Click ~ todelete the selected subscriptions from the deployment list for service group.

B, Click ** to synchronize your resources to the latest versions available on Live.
Name Displays name of the resource.
Created Displays date and time that the resource was created.
Updated Displays date and time that the resource was last updated.
Type Displays type of resource.
Description Displays description of the resource.
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Subscriptions Tab

Subscriptions are NetWitness Live resources to which you subscribed in the Live Search view or Live
Resource view. When you subscribe to a resource, you agree to receive updates on a regular basis from
NetWitness Live. The choices made in the Live Configuration panel determine the synchronization
frequency and also whether you receive update notifications through email. In addition, if you don't want
to wait for the next update, you can force an immediate synchronization.

The Subscriptions tab provides a way to manage subscriptions. Each resource to which NetWitness is
subscribed is listed in this tab.

In the Subscriptions tab, you can:
e View all resources to which this NetWitness instance is subscribed.
e Open a detailed view of a subscription in the Live Resource View.

¢ Delete a subscription.

Note: Subscribing to a resource does not deploy the resource to any services. To deploy one or more
subscribed resources, go to the Deployments tab. To deploy a single resource manually, use the
Deploy option in the Resource View.

The required permission to access this view is Manage Live Resources.

To access this view, in the main menu, select (Configure) > Subscriptions. The Subscriptions tab
is displayed.

NETWITNESS @ Home & Investigate

LIVE CONTENT  SUBSCRIPTIONS ~ CAPTURE POLICIES POLICIES ESA RULES CUSTOM FEEDS INCIDENT RULES INCIDENT NOTIFICATIONS

EU-EGTIELEN Deployments | Discontinued Resources

Certain services are managed by Centralized Content Management(CCM). To manage content subscription on those services, click here

[ Name Type Version Discontinued Updated Description
P p p

[ Microsoft Azure Log Device 58.31 no 2024-06-13 5:56 AM Log device content for event source Microsoft Azure -...
I Microsoft Windows Log Device 6514 no 2024-08-29 12:47 PM Log device content for event source Microsoft Windo.
[ [CIMicrosoft Office 365 Log Device 47.0 no 2024-07-12 6:06 AM Log device content for event source Microsoft Office

The Subscriptions tab has a toolbar and a grid.
Toolbar

This table describes the options available in the toolbar.

Description

Deletes the selected subscriptions.
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e Jowmn

Details

Grid

Displays the details of a single subscribed resource in the Resource View.

Check the Live Server for the latest discontinued resources.

o4

Name
Type
Version

Discontinued

Selects subscribed resources to view in detail or delete. You can view details for a single
resource. You can delete one or more resources from the subscribed resources, in effect
unsubscribing.

Displays name of the subscribed resource.
Displays type of subscribed resource.
Displays version of the subscribed resource.

Indicates the status of the discontinued resources for the subscribed resource.
Yes - Resource is discontinued.

No - Resource is not discontinued.

-- - The Live Server is not checked for the discontinued resources.

Updated Displays date and time when the subscribed resource was last updated.
Description Displays description of the subscribed resource.
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Discontinued Resources Tab

The Discontinued Resources tab provides a user interface in the Live Configure view:

e Scan the services for the discontinued resources.

o Remove the discontinued resources from any service or service group.

Note: Discontinued content still appears. With discontinued content there just won’t be any updates,
and users won’t see these items when they search in Live, unless they check the Include Discontinued
Resources box while searching.

In the RSA Content space on NetWitness Community, you can view the complete, up-to-date list of
discontinued resources (Discontinued Content). For each resource, there is a description of why it was
discontinued. Use these details to determine whether or not to remove a discontinued resource from your
installation. .

The required permission to access this view is Manage Live Resources.

To access this view:

1. Goto (Configure) > Subscriptions.
The Subscriptions tab is displayed.

2. Click the Discontinued Resources tab.
The Discontinued Resources tab is displayed.

NETWITNESS e & Inve (D Res )Hosts B F 08 [ 3 E

LIVE CONTENT  SUBSCRIPTIONS ~ CAPTURE POLICIES ~ POLICIES ~ ESARULES ~ CUSTOMFEEDS  INCIDENTRULES  INCIDENT NOTIFICATIONS ~ MORE v

(V- Hey o ER Iy Il Discontinued Resources

Groups Discontinued Resources on Service
EIC -

Name Address Type Name Type Version Discontinued  Updated Description

No Service was found to have
discontinued resources

The Discontinued tab has two panels: Groups and Discontinued Resources on Service.

Groups Panel

The Groups panel is a static display of configured service groups that were created in the Admin
Services view. Selecting a group in the Groups panel populates the Discontinued Resources panel with a
list of discontinued resources which are deployed on the selected service or service group.

e e N

a_p Click the button to scan the services for a discontinued resource.
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Displays the current status of the discontinued resources on a service.

Y

b Note: The status of a service may change while the services are being scanned.
Name Displays service group name. Clicking the plus sign displays a nested list of services in the group.
Address Displays IP address of each service in the group.
Type Displays type of service.

Discontinued Resources on Service Panel

The following table describes the features in the Discontinued Resources on Service panel.

o o

- Click the button to delete the selected resources from the service or service group.

Name This is the name of the resource.

Type This is the type of resource.

Version Version of the discontinued resource.

Discontinued Indicates the status of the discontinued resources for the subscribed resource.

Yes - The resource is discontinued.
No - The resource is not discontinued.
--- The Live Server is not checked for the discontinued resources.

Updated Displays date and time that the resource was last updated.

Description Displays description of the resource.
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Live Feeds View

Use the Live Feeds View to:
e Create custom feeds.

e Create identity feeds.

e Edit feeds.

The required role to access this view is Manage Devices.

To access this view, navigate to (Configure) > Custom Feeds.

This is an example of the Feeds view.

NETWITNESS
IPTIONS CAPTURE POLICIES POLICIES ES CUSTOM FEEDS INCIDENT RULES INCIDENT NOTIFICATIONS MORE v
+

Name Trigger Disk Usage Created Last Run Time Status Progress
o TEST Once - 2019-07-1313:30:36  2019-07-13 13:30:36  Completed e
B TEST2 Once Completed CaEEE—
K te Once Completed CEEE—
B onlydon Once Completed CEE——
o PCAP Once Completed aaEEE——

The Feeds tab has a toolbar and a grid.
Toolbar

This table describes the options in the toolbar.
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=%
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Feeds Grid

Initiates the creation of a custom or identify feed by displaying the Setup Feed dialog is displayed.

Setup Feed

(® Custom Feed

() Identity Feed

Cancel
o Custom Feed opens the Configure a Custom Feed wizard.
o |dentity Feed opens the Configure Identity Feeds wizard.

Deletes the feed that you selected.

Opens the Configure Custom Feed or Configure Identity Feed wizard for the feed that you selected

(see Editing a Feed.

Start or resume data feed.

Stop or pause data feed.

This table describes the columns in the grid.

T

Selects a feed.

Name Name of the feed.
Note: You can now use special characters to define the name of the custom feed.
Trigger Displays how often the feed runs which is determined by what you defined in Feed Task Type when
the feed was created.

Created Displays date and time when the feed was created.

Disk Usage Displays the MongoDB storage size used by the TAXII feed.

Last Run Displays date and time when the feed was last run.

Time

Status The status of the feed.

Progress Progress bar.
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Live Resource View

The Live Resource View shows a detailed view of a selected resource, and has the following options:
e Download the resource.

* Subscribe or unsubscribe the resource.

¢ Deploy the resource to services.

e Locate services on which the resource is deployed and remove the resource from services.

The required permission to access this view is View Live Resource Details.

To access this view, do one of the following:

1. Goto (Configure) > LIVE CONTENT > Search Criteria.
2. In the Live Search view, Detailed Results, click the resource type icon or the resource name.

3. In the Live Search view, Grid Results, double-click a resource or select a resource and click Details.

This is an example of the Resource view.

NETWITNESS ™ Home &

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES ESA RULES CUSTOM FEEDS NCIDENT RULES INCIDENT NOTIFICATIONS MORE

3. Download 3 Subscribe .8 Deploy €3 Service Locator

i Injecting Web Shell to ColdFusion

type Application Rule

created 2022-10-27 12:29 PM

updated 2022-11-29 3:47 PM

description Identifies shell processes such as 'cmd.exe' or powershell being

spawned by a ColdFusion process. Suspicious processes launched by
ColdFusion may indicate a compromise of the web server. Investigate
the command being run and attempt to determine their purpose. Look
for signs of further activity from a potential malicious actor, such as
host or network discovery commands being executed, as these often
precede attempts at lateral movement.

VERSIONS SUPPORTED
* NetWitness Platform 11.5 and higher

DEPENDENCIES

* NetWitness Endpoint Server

The Live Resource View has a detailed view of a single resource and a toolbar.

Resource Details

The following table describes the elements in the Resource Details section.

Description
Resource A graphic representation of the resource type, for example ¢
Type Icon E‘
Name The name of the resource, for example, fingerprint_office lua,
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Type
Created
Updated
Description
Version in
production
Size

Required
Resources

Tagged as

L

Required
Meta Keys

Generates
Meta Values

Permissions

The type of resource, for example, RSA Lua Parser,
The date the resource was created, for example, 2013-09-15 02:16 PM,
The date the resource was last updated, for example, 2013-09-15 02:16 PM

The description of the resource, for example, Identifies Microsoft Office 95, 2007 Word, Excel, and
PowerPoint documents,

The version of the resource, for example, 0.1,

The size of the resource, for example, 9.079 KB,

A list of resources on which this resource depends, for example, NetWitness Lua Library. Clicking a
resource replaces the currently displayed details with the details of the one you clicked.

The tags that apply to the resource. In the example, the tags are featured, informational. Clicking a
tag opens the Live Search View with the search narrowed to match resources with that tag.

The meta keys 40 that apply to the resource. In the example, there are no meta keys required. Clicking a

meta key opens the Live Search View with the search narrowed to match resources with that meta key.

The meta values @ that the resource generates. In the example, there are no meta values generated.

Clicking a meta value opens the Live Search View with the search narrowed to match resources with that
meta value.

The permissions required for the resource.

Resource View Toolbar

This table describes the Live Resource view toolbar options.

e o o

Download

Subscribe or
Unsubscribe

This option downloads the resource currently displayed
Iil Download in the Resource View.
.,.I"h,. cubscribe This option subscribes to or unsubscribes from the

resource currently displayed in the Resource View.

3 Unsubscribe ¢ Clicking Subscribe opens a dialog notifying that you

are agreeing to receive notification when the
selected resources are updated. You can cancel or
click OK.

¢ Clicking Unsubscribe asks for confirmation that you
want to stop receiving notification when the selected
resources are updated. You can then choose to
cancel or you can click Unsubscribe or
Unsubscribe and Remove, which also removes the
resource from services on which it is deployed.

Deploy 'E. Deploy This option provides a way to deploy the resource
o currently displayed in the Resource View. Clicking
Deploy opens the Manual Resource Deployment dialog.
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Service

' This option displays a list of services on which the
Locator EB Service Locator currently displayed resource is deployed. You can
remove the resource from all services or selected
services.
Deploy Content
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Live Search View

The Live Search view provides the ability to browse the configured Live CMS for resources. Once
matching resources are found, you can view details, subscribe to resources, and deploy resources to
services and service groups.

Note: If you are logged into an Analyst UI, you can only view but cannot enable, disable, edit, or
configure NetWitness Live.

This is an example of the Search view.

NETWITNESS

ONTENT

Search Criteria

Keywords

Category
[ FEATURED
» [ THREAT
» CJIDENTITY
» CJASSURANCE
» [ OPERATIONS
[JSPECTRUM

[ MALWARE ANALYSIS

Resource Types

Medium

Required Meta Keys

Generated Meta Values

Resource Created Date:

Start Date

Resource Modified Date:

APTURE POL

Matching Resources

[ show Results |

Certain services are managed by Centralized Content Management(CCM). To manage content on those services,

Subscribed Name

Injecting Web Shell to Cold
Endpoint Pack

Host Traffic to External IP C...
Runs Powershell Command..
Possible Port Scanning Det...
Possible SMB Scanning Det...
Packet Starter Pack

Known Threats Pack

0365 - Mass SharePoint Fil...
EC2 - Multiple instances ter...
11.3 Rarest Code Signing C..
Confluence Web Shell Activi..
11.3 Autoruns and Schedul
GCP - Multiple vm instance..
Suspicious sdiagnhost.exe ...
11.3 Endpoint Indicators by..
NetWitness Administration ...
Potential APT Service Install
Outbound BazarLoader DN

Modifies Windows Security ...

394 Matching Resources

TOM FEEDS

Created

2022-10-27 12:29 PM

2019-04-10 3:45 PM

2022-06-08 6:53 PM

2022-10-18 6:28 AM

2022-09-15 3:56 PM

2022-09-15 3:54 PM

2016-12-30 5:53 PM

2017-06-06 4:28 PM

2022-12-07 2:28 PM

2021-09-14 6:55 AM

2019-04-10 1:52 PM

2022-10-27 11:52 AM

2019-04-10 1:51 PM

2022-02-04 11:47 AM

2022-07-20 6:10 PM

2019-04-10 1:51 PM

2018-07-18 9:20 PM

2015-07-02 7:11 AM

2022-01-28 2:50 PM

2022-10-18 6:21 AM

NCIDENT NOTIFIC

¥ Package

Updated
2022-11-29 3:47 PM
2023-03-08 3:22 PM
2023-08-31 6:34 AM
2022-11-29 5:39 PM
2023-06-15 2:57 PM
2023-06-15 2:57 PM
2023-01-19 4:04 PM
2023-01-19 3:47 PM
2022-12-216:11 PM
2021-09-14 6:55 AM
2019-04-10 2:02 PM
2022-10-27 11:52 AM
2019-04-10 2:02 PM
2022-02-04 11:47 AM
2022-10-27 7:25 AM
2019-04-10 2:02 PM
2018-07-18 9:23 PM
2017-09-23 5:36 AM
2022-01-28 2:50 PM

2022-10-18 6:21 AM

Type
Application Rule
Bundle

Application Rule
Application Rule
Application Rule
Application Rule
Bundle

Bundle

Event Stream Anal.

Event Stream Anal.

NetWitness Rule
Application Rule

NetWitness Rule

Event Stream Anal.

Application Rule
NetWitness Rule

NetWitness Rule

Event Stream Anal...

Application Rule

Application Rule

Description
Identifies shell processes such as ‘cmd.exe' or powerst
Deploying this bundle will download all of the content
Many malwares, once successfully compromising a ho
Running remote powershell command can be an indic
Adversaries may execute active reconnaissance scans
Adversaries may execute active reconnaissance scans
This pack contains a set of starter content specific to p
This pack contains a set of content specific to known ic
This rule triggers when the specified number of Sharel
This rule triggers when specified number of EC2 instar
Details of Child Processes of web server. Web Shells cz
Identifies shell processes such as ‘cmd.exe' or Powerst
Attackers will often use registry autoruns and schedule
This rule triggers when the specified number of VM ins
This rule alerts on Scripted Diagnostics Native Host cre
Number of risk indicators associated with each host br
This Rule gives a summary of event types and sub type
10.4 or higher. Detects a host making a connection to
BazarLoader (Also known as Baza, Bazaloader) is a file

This rule detects a Non-Microsoft binary modifying sec

»

The Live Search view has a panel for specifying search criteria and a panel that displays matching
resources. The Search Criteria panel is collapsible to provide more width for viewing the Matching

Resources panel.

Search Criteria Panel

This is an example of the Search Criteria panel.
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Search Criteria

Keywords

Category
[ FEATURED
» CJTHREAT
» [ IDENTITY
» CJASSURANCE

» (] OPERATIONS

Resource Types

Medium

Required Meta Keys

Generated Meta Values

Resource Created Date:

Start Date End Date

Resource Madified Date:

The following table provides descriptions of the Search Criteria panel features.

Keywords

Category

Description

Enter a keyword or keywords to browse for resources that have the keyword
in the resource name or the resource description. You can use wildcards
when you enter a keyword.

The categories mirror the hierarchical Investigation Model that NetWitness
uses to organize resources. The purpose of the Investigation model is to
deliver an accurate path to information security incident response. For more

information, see the [nvestigation Model topic in the NetWitness
Content space on NetWitness Community.
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e

Resource Types Select resources types from the drop-down list to filter resources by type of
resource. Possible values are:

¢ Advanced Analytics (Warehouse)

e Application Rule

* Bundle

e Correlation Rule

e Event Stream Analysis Rule
e Feed

e FlexParser

 Investigation Column Group
* Investigation Meta Group

* Investigation Profile

¢ Log Collector

¢ Log Device

* Lua Parser

e Malware Rules

e NetWitness List

¢ NetWitness Report

¢ NetWitness Rule

e (Latest Versionss) Health and Wellness Dashboards

e (Latest Versions) Health and Wellness Monitors

Note: Some rules that have been deployed to an earlier version of NetWitness
may not deploy or execute on NetWitness . For more information, see the

Troubleshooting Live Services.
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Medium

Tags

Required Meta Key(s)

Generated Meta Value(s)

Research Created Date

Research Modified Date

Search

Cancel

Include Discontinued Resources

Matching Resources Panel

Select one or more mediums from the drop-down list to search for content
based on the meta data source.

Available values for medium are as follows:

* endpoint: for NetWitness latest verisons: applied to content that
uses meta derived from endpoint agent and endpoint server data

 log: applied to content that uses meta derived from log data

e packet: applied to content that uses meta derived from network
packets

* log and packet: applied to content that correlates meta derived
across log and packet data

Select meta tags from the drop-down list to browse based on how the meta is
tagged. For example, to browse resources for a Log Decoder, select the
netwitness for logs tag. Alternatively, you can click a tag in the Matching
Resources panel to insert that tag in this field.

Enter a specific meta key; for example, threat.source, Alternatively, you can
click a meta key in the Matching Resources panel to insert that tag in this field.

Enter a generated meta value; for example, netwitness, Alternatively, you can
click a generated meta key in the Matching Resources panel to insert that tag in
this field.

Specify a date range during which resources were created. For example, to browse
resources that were created between January 1 and January 4, you select January 1
as the start date and January 4 as the end date. You must enter dates in
mm/dd/yyyy format or you click and pick dates from a calendar.

Specify a date range during which resources were modified. For example, to
browse resources that were modified between January 1 and January 4, you select
January 1 as the start date and January 4 as the end date. You must enter dates in
mm/dd/yyyy format or you click and pick dates from a calendar.

Click Search to send the search request to the Live server. More specific search
criteria return matching resources more quickly.

Click Cancel to cancel the search in progress.

Check Include Discontinued Resources to include the discontinued
resources in the search result. For an up-to-date list of resources that have

been discontinued, see the Discontinued Content topic.

The Matching Resources panel displays search results based on the selections made in the Search
Criteria panel. Results are initially displayed in a grid, but you can switch between two Show Results

options: Detailed or Grid.

Detailed Results

In the detailed results, you can click a tag, meta key, or resource meta value to auto fill the Search
Criteria panel and pivot the search results.
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The following table describes the elements in the detailed results.

roan ommn

Resource
Type Icon

Name

Type
Updated
Version
Size

Subscribed

Description

Tags

Meta Keys

Resource
Meta Values

Grid Results

A graphic representation of the resource type. For example

The name of the resource, for example, Group Management.

Note: (Discontinued) is displayed next to the resource name if a resource is discontinued.

The type of the resource, for example, Rule.

The date when the resource was last updated, for example, 2015-09-15 4:27 PM.

The version of the resource, for example, 0.1.

The size of the resource, for example, 153 B.

Subscription status:

¢ yes: This NetWitness instance is subscribed to this content resource.

¢ no: This NetWitness instance has not subscribed to this content resource.
The description of the resource, for example, Compliance Rule-Group Management.

The tags that apply to the resource. Clicking a tag narrows the search to resources with that tag. For

L

example, .

The meta keys that apply to the resource. Clicking a meta key narrows the search to resources with

£

that meta key. For example, .

The meta values generated by the resource. Clicking a meta value narrows the search to resources

that generated the meta value. For example, E .

In the grid view, you can select one or more resources and use additional options in the toolbar to view
the details of a single resource, subscribe to resources, and deploy resources.

The following table describes the elements in the grid results.

e

Subscribed Subscription status:
¢ yes: This NetWitness instance is subscribed to this content resource.
¢ no: This NetWitness instance has not subscribed to this content resource.
Name The name of the resource, for example, Group Management.
Note: The resource name is displayed in red color if it is discontinued.
Created The date when the resource was created, for example, 2015-08-12 3:11 PM,
106 Deploy Content



Live Services Management Guide

o o

Updated The date when the resource was last updated, for example, 2015-09-15 4:27 PM,

Type The type of the resource, for example, Rule,

Discontinued The status of the discontinued resources:
e yes: The resource that matches the search criteria is discontinued

e no: The resource is not discontinued

e --: The Live Server is not checked for the discontinued resources

Description The description of the resource, for example, Compliance Rule-Group Management.
Toolbar

Show Besuli This menu offers two ways to view search results: Detailed and Grid,

Details This option applies to a single selected resource. Clicking Details opens the selected resource in the Live
Resource view.

:I_E,‘: Deploy This option applies to one or more selected resources.

A Subscribe This option applies to one or more selected resources. Clicking Subscribe opens a dialog that
' asks for confirmation that you want to receive notification when the selected resources are
updated.

;{: Package ~ This menu offers two packaging functions for the selected resources:

e Create: creates a resourceBundle.zip file that contains the selected resources and opens a
dialog in which you can either:

e open thefile, or
¢ save the file for subsequent deployment.

o Deploy: opens the Deployment Wizard, in which you can choose a resourceBundle.zip file
and deploy it.

See Also

* For more information on Deployment ( E. Deploy), see Find and Deploy Live Resources.

For more information on Deploying a Package (:’t Package ), see the Resource Package

Deployment Wizard,.
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Live Search Content View

The Live Search Content view provides the ability to search the configured Live CMS for content. Once
matching content are found, you can view the details, and download the content.

This is an example of the Search Content view.

NETWITNESS

Content community content details here.

9 Mew Community My Content

Recently Updated
Showing Recently Updated Content (3) Timezone : GMT+0530 Asia/Calcutta

FirstWatch Content @
Search Content CREATED 4 UPDATED ¢ 5 MIN PLATFORM VERSION §
20-Sep-2024 14:05. 20-Sep-2024 14:05: ee 11500
Al V

Al Versions

NETWITNESS

nt

@an ntly updated and community content details here.
New Netwitness My Content

Recently Updated

Showing New Content (3) Timezone : GMT+0530 Asia/Calcutta

FirstWatch Content @
Search Content CREATED 4 UPDATED § TYPE § MIN PLATFORM VERSION § DESCRIPTION &
26-Aug-202418:07..  26-Aug202418:07..  EventStreamAnaly..  AllVersions description myadav esa 1 test
Log Device Al Versions myadav Id zip1

Log Device 11500 myadav LD 9 test file

The Live Search Content view has a panel for selecting the source and specifying search content. The
matching content are displayed on the right panel.

The following table provides descriptions of the Live Search Content panel features.

Description

NetWitness Select NetWitness tab to search for the content that is provided by NetWitness
Platform Live.

Community  Select Community tab to search for the content collected and retrieved from third
party and open source communities.

New Select New to retrieve the content which is created in the last 21 days.
Recently Select Recently Updated to retrieve the content which is updated in the last 21 days.
Updated

FirstWatch Content Panel

This is an example of the FirstWatch Content panel.
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NETWITNESS

Content ew, recently updated and community content details here.
FirstWatch Content @ Community My Content

> New Showing All FirstWatch Content (2) Timezone : GMT+0530 Asia/Calcutta

All

Search Content MIN PLATFORM VERSION 4 DESCRIPTION 3

11500 Content for testing-updated

12500 Content for testing-updated

The following table provides descriptions of the FirstWatch Content panel features.

Description
New Select New to retrieve the FirstWatch content which is created in the last 21 days.
All Select All to retrieve complete list of the FirstWatch content.

Search Content Panel

This is an example of the Search Content panel.
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Search Content

Show Only FirstWatch Content

KEYWORDS

RESOURCE TYPES

MEDIUMS

PLATFORM VERSIONS
12.5.00

ATT&CK TACTICS

ATT&CK TECHNIQUES

REQUIRED META KEYS

GENERATED META VALUES

CREATED DATE

MODIFIED DATE

Include Discontinued

Reset Filter

The following table provides descriptions of the Search Content panel features.

e e

Show Only Click the Show Only FirstWatch Content checkbox to include only the FirstWatch

FirstWatch content in the search results.

Content The Show Only FirstWatch Content option is only applicable for the content
displayed in the NetWitness tab.

Keywords Enter a keyword or keywords to browse for content that have the keyword in the
resource name or the resource description. You can use wildcards when you enter a
keyword.
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Resource Select resources types from the drop-down list to filter resources by type of resource.
Types Possible values are:

e Application Rule

e Feed

e Log Device

e Correlation Rule

¢ NetWitness Rule

¢ NetWitness Report

e Lua Parser

e Log Collector

e NetWitness List

¢ Malware Rules

* Event Stream Analysis Rule

e Advanced Analytics (Warehouse)
e Bundle

e Health and Wellness Dashboards
* Health and Wellness Monitors

* Investigate Profile

¢ Investigate Column Group

¢ Investigate Meta Group

Mediums Select one or more mediums from the drop-down list to search for content based on
the meta data source.
Available values for medium are as follows:
 endpoint: applied to content that uses meta derived from endpoint agent and
endpoint server data

» log: applied to content that uses meta derived from log data
o packet: applied to content that uses meta derived from network packets

 log and packet: applied to content that correlates meta derived across log and
packet data.

Risk Select the level of risk of the content from the drop-down list to view. Available are
High, Medium, and Low.
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Tags

Platform
Versions

ATT&CK
Tactics

ATT&CK
Techniques

Required
Meta Keys

Generated
Meta Values

Created Date

Modified Date

Search

Reset Filter

Include
Discontinued

Select meta tags from the drop-down list to browse based on how the meta is tagged.
For example, to browse content for a Log Decoder, select the netwitness for logs
tag.

Select one or more platform versions from the drop-down list to search for content
based on the versions. For example, 12.5.0.0.

Select one or more platform Mitre ATT&CK tactics from the drop-down list. For
example, Command and Control: TA0011,

Select one or more platform Mitre ATT&CK techniques from the drop-down list.
For example, DNS: T1071.004.

Enter a specific meta key. For example, threat.source.

Enter a generated meta value. For example, rsa-firstwatch.

Specify a date range during which content were created. For example, to browse
content that were created between January 1 and January 4, you select January 1 as
the start date and January 4 as the end date. You must enter dates in yyyy/mm/dd
format or you click &l and pick dates from a calendar.

Specify a date range during which content were modified. For example, to browse
content that were modified between January 1 and January 4, you select January 1 as
the start date and January 4 as the end date. You must enter dates in yyyy/mm/dd
format or you click [ and pick dates from a calendar.

Click Search to send the search request to the Live server. More specific search
criteria return matching content more quickly.

Click Reset Filter to reset the existing search results and displays all the content on
the right panel.

Click the Include Discontinued checkbox to include the discontinued content in the
search result. For an up-to-date list of content that have been discontinued, see the
Discontinued Content topic.

Search Results Panel

The Search Results panel displays search results based on the selections made in the Search Content

panel.

This is an example of the Search Results panel.
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& Content

View New, recently updated and community content details here.

Community My Content

Showing Filtered Content (2363) Timezone : GMT+0530 Asia/Calcutta

CREATED 4 UPDATED # TYPE MIN PLATFORM VERSION % DESCRIPTION *

11-Sep-202001:23.... 10-Sep-2024 1 Feed All Versions This feed contains Non-IP Address, text based indicators like Host...

11-Sep-202001:23.... 10-Sep-2024 10:01:... Feed All Versions This feed contains IP Address (IPv4 and IPvé) indicators that aress...

05-Feb-2024 14:53.... 23-Jul-2024 17:36.... Log Collector 12.3.00 Log Collector content for Logstash jdbc mssql auditing Pipeline

28-Apr-2023 08:44.... 23-Jul-2024 18:36.... Log Collector Log Collector content for Logstash jdbc custom Pipeline

14-Apr-2023 15:58.... 23-Jul-2024 18:35:... Log Collector Log Collector content for Logstash jdbc ibmdb2 auditing Pipeline

03-Apr-2023 11:51:... 30-Jul-2024 10:58.... Log Collector Log Collector content for Logstash jdbc oracle 19c auditing Pipeline

14-Apr-2023 15:43.... 23-Jul-2024 17:34:... Log Collector .3.04 Log Collector content for Logstash jdbc oracle 12c auditing Pipeline

06-Mar-2023 15:01... 23-Jul-2024 17:34.... Log Collector Log Collector content for Logstash jdbc oracle 11g auditing Pipeline

15-Mar-2023 12:36... 23-Jul-2024 17:34.... Log Collector Log Collector content for Logstash jdbc oracle 18c auditing Pipeline

17-May-2023 15:0... 23-Jul-2024 14: Log Collector Log Collector content for Logstash jdbc ibmdb2 auditing Pipeline

17-May-2023 15:1... 23-Jul-2024 14:02.... Log Collector .3.0. Log Collector content for Logstash jdbc oracle 11g auditing Pipeline

The following table describes the elements in the search results panel.

Description

Name The name of the content. For example, Log Parser Pack.
For FirstWatch Content, the name of the content has label.

Created The date when the content was created. For example, 04-Aug-2017 15:19:06,

Updated The date when the content was last updated. For example, 29-Sep-
2020 20:27:14.

Type The type of the content. For example, Bundle,

Min Platform Platform version that the content supports. For example, 12.4.2.0
Version
Description The description of the content. For example, Contains all parser files and log

collection files.

Discontinued The status of the discontinued content:
¢ Yes: The content that matches the search criteria is discontinued

¢ No: The content is not discontinued

Content Details Panel

In the Search Results panel, you can select any content titles to view the details in the pop-up window
and download the content.
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Note: NetWitness provides no assurance related to the quality and accuracy of the content provided by
the third parties and open source communities.

This is an example of the Content Details panel.

Content Details

NOTE: The following content is collected and derived from third-party, open sources. RSA
[NetWitness] at no times makes claims to the quality and/or efficacy above and beyond the
attestations of the authors of the content itself.

[Community] Malware, Malicious Code and APT Open Source YARA
Rules

TYPE

Malware Rules

UPDATED

16-Feb-2022 21:40:00

DESCRIPTION

The following corpus of YARA rules focus on the detection, identification, and analysis of various forms and
types of malicious code & content (malware) and in some cases those threat actors/adversaries associated
with their use and proliferation. These YARA rules have been collected from the open-source community and
are being made available to our customers via our NetWitness Live Community capability.

Mediums

None

@ Large files may take longer time to start the download. Close Download

The following table describes the elements in the Content Details section.

Name The name of the content. For example, Log Parser Pack.

Type The type of the content. For example, Bundle,

Created The date when the content was created. For example, 04-Aug-2017 15:19:06,

Updated The date when the content was last updated. For example, 29-Sep-2020 20:27:14.

Description The description of the content. For example, Contains all parser files and log
collection files.

Risk The level of severity for the Content. For example, High,

Tactics The particular tactics associated with the content. For example, Command and
Control: TA0011.

Techniques The particular techniques associated with the content. For example, DNS:
T1071.004,
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o o

Version on The version of the content. For example, 0.5.

Production

Size The size of the content. For example, 14.96 KB.

Required A list of resources on which this resource depends. For example, NetWitness Lua

Resources Library. Clicking a resource replaces the currently displayed details with the details
of the one you clicked in the pop-up window.

Tags The tags that apply to the content. For example, threat. Clicking a tag opens the
Live Search Content view with the search narrowed to match content with that tag.

Required The meta keys that apply to the content. For example, Threat Category. Clicking a

Meta Keys meta key opens the Live Search Content view with the search narrowed to match

content with that meta key.

Generated The meta values that the content generates. For example, rsa-firstwatch. Clicking a
Meta Values meta value opens the Live Search Content view with the search narrowed to match
content with that meta value.

OOTB The content provided NetWitness Platform Live.
Discontinued The status of the discontinued content:
¢ Yes: The content that matches the search criteria is discontinued

¢ No: The content is not discontinued

My Content Panel

Following task you can perform on the My Content panel.
e Upload Content

e Delete Content

e Download Content

This is an example of the My Content panel.
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NETWITNESS

Content

FirstWatch Content @ Netwitness Community

Search Content Showing My Content{43) Timezone : GMT+0530 Asia/Calcutta

2 Upload Content

NAME CREATED * TYPE § INDUSTRY SECTOR 4 STATUS 4 MIN PLATFORM VERSION 4

01-Aug-2024 14:01:04 Log Device Chemical Failed All Versions

30-Jul-2024 11:20:33 Event Stream Analysis R... Energy Rejected All Versions

30-Jul-2024 11:06:39 Event Stream Analysis R... Defense Industrial Base Published All Versions

30-Jul-2024 10:51:52 Event Stream Analysis R. Defense Industrial Base Published All Versions

29-Jul-2024 11:30:15 Event Stream Analysis R... Communications Rejected All Versions

29-Jul-2024 10:38:39 Event Stream Analysis R... Dams Rejected All Versions

29-Jul-2024 10:28:02 Event Stream Analysis R... Dams Rejected 12.400

29-Jul-2024 10:08:38 Event Stream Analysis R... Information Technology Rejected 12310

29-Jul-2024 10:01:38 Event Stream Analysis R... Defense Industrial Base Rejected 12.400

The following table describes the elements in the My Content section.

Description

Name The name of the uploaded content. For example, Logtest.
Created The date when the content was created. For example, 23-Aug-2024 11:22:48,
Type The type of the content. For example, Log Device.

Industry Sector  The industry sector the content belongs to. For example, Defense Industrial Base.

Status The status of the uploaded content. Available statuses are Under Review,
Published, Rejected, and Failed.

Min Platform Platform version that the content supports. For example, 12.5.0.0.

Version
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Resource Package Deployment Wizard

If you have created a package of resources and saved it on a network drive, you can use the Resource
Package Deployment Wizard to deploy the resources manually to a service or a service group without
subscribing to the resources. NetWitness accepts packages in .nwp files or .zip files.

Deploying resources manually deploys them directly to the services without taking advantage of the
powerful resource management capabilities of NetWitness.

If you want to receive notification and updates for updated resources and be able to easily remove
resources from a service, you must subscribe to resources in the Live Search view and deploy the
resources in the Live Configure view.

Note: Use NetWitness Live to create resource bundles; this is a different application that is not part of
NetWitness. Selecting Package > Create in the Live Search - Matching Resources toolbar displays
the Content Package Tool window. You can choose resources to include in a package and save the
package as a NetWitness Package File.

The required permission to access this view is Deploy Live Resources.

To access this view:

1. Goto (Configure) > Live Content.

& Package ~

2. In the Live Search - Matching Resources toolbar, select > Deploy.

The Resource Package Deployment wizard is displayed.

Resource Package Deployment

Package Resources Services Review Deploy

Resource Bundle Browse

Cancel Next.

Features

The Deployment Wizard has five tabs: Package, Resources, Services, Review and Deploy.
Use Close to exit before you complete the wizard.

When you complete the wizard, NetWitness returns to the Live Resources View.

Package Tab

You use this tab to select a resource bundle from your network in this page.

This is an example of the Package tab, with a resource bundle already selected.
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Resource Package Deployment

Package Resources Services Review Deploy

Resource Bundle  resourceBundle3866217298122437775.zip Browse

Cancel Next

The following table describes the elements in the Package tab.

Resource The input field to specify a resource bundle. You can type a path in this field or search using the

Bundle rows
. < button.

Command Buttons

Browse This button opens a File Upload dialog in which you can browse the local file system and select a
bundle.

Cancel Cancels the deployment and closes the wizard.

Next Displays the next tab of the wizard.

Resources Tab

This tab displays the resources contained in the bundle.

The following figure shows an example of the Resources tab.

Resource Package Deployment
Package Resources Services Review Deploy
Total resources : 2

Resource Names Resource Type Dependency Of
suspicious php put long query RSA Application Rule

APT Domain Intelligence RSA Application Rule

Cancel Next

The following table describes elements in the Resources tab.

Resource Name  Displays the name of the resources in the bundle (for example, NetWitness Lua Library),

Resource Type  Displays the resource types for the resources in the bundle (for example, RSA Lua Parser)

Dependency Of  Displays Resources on which the selected resource depends (for example, AIM lua),

Services Tab

You select the services on which you want to deploy the resources in the bundle.
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The Services tab has two tabs, Services and Groups. These provide a list of services and service groups

4
that are configured in the (Admin) > Services view. The columns are a subset of the columns
available in the Services view. You can select the services or the service groups on which you want to
deploy the resources in the bundle.

This is an example of the Services tab.

Resource Package Deployment

Package Resources Services Review Deploy

O # Name ~ Type

Decoder
Decoder
Decoder

Log Decoder

O

Decoder
Log Decoder
Decoder
Decoder
Decoder
Log Decoder

Log Decoder

O O
W NN RN RN W WY

Decoder

Cancel Previous Next

The following table describes the elements in the Services tab.

Services
D Selects services on which you want to deploy the content. You can select any combination of services and
service groups.
Name Displays the services in your environment on which you can deploy the content.
Host Displays the name of the resource host.
Type Displays the type of NetWitness service.
Groups

D Selects service groups (if you have service groups defined in your environment).

Name Displays the names of the service groups.
Review Tab

Displays the resources and services on which the resources will be deployed.

In this tab, you can do the following:
e Review the content and services before you deploy.

* Initiate the deployment of the resources.

The following figure shows an example of the Review tab.
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Resource Package Deployment

Package Resources Services Review Deploy
Service Service Type Resource Name Resource Type
Decoder suspicious php put long query RSA Application Rule
APT Domain Intelligence RSA Application Rule
Cancel Previous Deploy

The following table describes the elements in the Review tab.

Service Information
Service Displays the services in your environment on which you can deploy the content.
Service Type Displays the type of each NetWitness service (type of host or service).
Resource Information
Resource Name  Displays the name of the resources you have selected (for example, NetWitness Lua Library),
Resource Type  Displays the resource types for the resources you have selected (for example, RSA Lua Parser),

Deploy Initiates the deployment of the resources and displays the Deploy page (final page of the wizard).

Deploy Tab

This tab allows you to do the following:
¢ View the progress of the job
¢ Cancel the job

This is an example of the Deploy tab.

Resource Package Deployment

Package Resources Services Review

Service Name Resource Name Status Progress

0of2

Cancel

The following table describes the elements in the Deploy tab.

N

Service Name of the services to which resources are deployed.
Name

Resource Name of the resources.

Name

120



Live Services Management Guide

o Jowamn

Status

Progress

Close
Errors

Retry

Status of the manual deployment.

Progress of the manual deployment in a progress bar. When complete, the bar turns solid green.
Command Buttons

Closes the wizard.

Only displays if NetWitness encountered any errors. Click to display the errors.

Only displays if NetWitness encountered any errors. Click this button to try to deploy the resources
again using the wizard.
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NetWitness Live Registration Portal

The NetWitness Live Registration Portal is a self-service wizard in which customers can set up a Live
account and change or reset the password. A Live account is required to get access to the feeds, parsers,
rules, and other content in NetWitness Live library. To access the portal, go to the following

URL: https://live.netwitness.com/registration/.

Welcome to RSA Live Registration Portal

NETWITNESS

Thank you for using RSA NetWitness.
Please sign up here for your RSA Live account to access your subscription content.

Sign Up for Netwitness Live Account @

End User License Agreement

First Name

THIS SOFTWARE CONTAINS COMPUTER PROGRAMS AND OTHER PROPRIETARY
MATERIAL AND INFORMATION, THE USE OF WHICH IS SUBJECT TO AND EXPRESSLY
CONDITIONED UPON ACCEPTANCE OF THIS END USER LICENSE AGREEMENT (THE
“AGREEMENT").

THIS AGREEMENT IS A LEGALLY BINDING DOCUMENT BETWEEN YOU (MEANING
THE INDIVIDUAL PERSON OR THE ENTITY THAT THE INDIVIDUAL REPRESENTS
THAT HAS OBTAINED THE SOFTWARE AND HARDWARE FOR ITS INTERNAL
PRODUCTIVE USE AND NOT FOR OUTRIGHT RESALE) (THE “CUSTOMER") AND
NETWITNESS (WHICH MEANS (1) RSA SECURITY LLC, IF CUSTOMER IS LOCATED IN
THE UNITED STATES, MEXICO OR SOUTH AMERICA; (Il) THE LOCAL NETWITNESS
SALES AFFILIATE, IF CUSTOMER IS LOCATED OUTSIDE THE UNITED STATES, MEXICO
OR SOUTH AMERICA AND IN A COUNTRY IN WHICH NETWITNESS HAS A LOCAL
SALES AFFILIATE; OR (lll) RSA SECURITY & RISK IRELAND LIMITED OR OTHER
AUTHORIZED NETWITNESS ENTITY AS IDENTIFIED ON THE NETWITNESS QUOTE
OR OTHER NETWITNESS ORDERING DOCUMENT, IF CUSTOMER IS LOCATED
OUTSIDE THE UNITED STATES, MEXICO OR SOUTH AMERICA AND IN A COUNTRY IN
WHICH NETWITNESS DOES NOT HAVE A LOCAL SALES AFFILIATE). Unless
NetWitness agrees otherwise in writing, this Agreement governs Customer's use of the
Software and Hardware, except to the extent all or any portion of the Software or
Hardware is: (a) the subject of a separate written agreement set forth in a quotation

CREATE ACCOUNT

ACCEPT

Click Sign Up For Live. The License Agreement page is displayed, once you agree to the Terms and
Conditions, click Accept: the fields for setting up an account are displayed. These include Contact
Information, and License ID.

The following table lists the contact information section fields and its descriptions:

Parameter | Description

First Name Your first name.

Last Name Your last name.

Company The name of your company.

Email The email address where you want to receive notifications related to the Live
account.

License ID

This is the License ID on the Kl (Admin) > System > Info page.

Caution:
The license ID on the NetWitness must be valid and must be registered on the
Flexera Server. If not, contact NetWitness Customer Support.

Username The username used to sign in to NetWitness Live account. The username must
contain a minimum of four characters and a maximum of 16 characters.
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Password The password for the NetWitness Live account. The password must contain minimum
of eight characters and the maximum length is 24, with at least one uppercase, one
lowercase, one number, and one special character.
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NetWitness Feedback and Data Sharing

The Live Feedback Activity Log enables you to download the usage data required for Live Feedback.
After you download the Live Feedback data, you can then upload it to share with NetWitness.

QA
The settings for these features are available in (Admin) > System > Live Services view,

in the Additional Live Services section.

Additional Live Services

4
Participation in the Additional Live Services is configured in the (Admin) > System > Live
Services view.

Live Feedback

Note: For NetWitness latest versions, this section in the Ul has been removed. NetWitness has created
the Customer Experience Improvement Program. For details, see "Configure the Customer Experience
Improvement Program" in the NetWitness System Configuration Guide.

Live Feedback is intended to help improve NetWitness.

Aaoditional Live Services
Live Feedback

R5A collects details about the services you use in your deployment for new features and other improvements to the

platform. Informaticn collected is securely sent to RSA.
[+ Additional Feedback Insights
B

Send additional information to improve feature usage, Learn maore

Once you set up and configure a Live account, usage data is automatically shared with NetWitness and is
protected in accordance with the applicable license agreement. All such data shall be anonymized and
shall not have any Personally Identifiable Information.

Before data is sent to NetWitness, all Personally Identifiable Information is removed. Thus, only
anonymous usage data gets transferred to NetWitness.

For more information, see the "Live Feedback Overview" topic in the System Configuration Guide.

File Reputation

File Reputation service provides instant access to the latest signatures using the RSA Live feed so data is
more relevant, with fewer false positives. With this service, users always have reliable data about the
reputation of files in their NetWitness Endpoint system. In addition to the whitelisting service, it
provides blacklisting information as well.
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File Reputation

[+ Enahle File Reputation ) Mot Connected
This option is used to view reputation status of files. The File Hash information from NetWitness Platform is sent to
R5A Live to get the reputation status. Reputation status is leveraged by analysts during investigation of files,.Learn
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This section provides troubleshooting instructions for issues faced when using the Live Services module
in NetWitness.

OutOfMemoryError on Context Hub Server

You may encounter an OutOfMemoryError on Context Hub server, and the service becomes
unresponsive.

If there are any TAXII feeds configured, Health and Wellness raises alerts when the available heap
memory of Context Hub server is critically low. If the status of Context Hub server is Unhealthy because
of low memory, perform the following steps:

1. Make sure that the feeds Start Date is within 180 days.

2. Check if any TAXII feed is consuming too much disk space. A TAXII feed can consume maximum
of 300 MB. If it consumes more disk space, you must reduce the value in the Remove STIX data
older than field under Advanced Options in the Custom Feed Creation Wizard when you edit a
TAXII feeds.

Note: If the issue still persists, you must execute step 3.

3. To decrease the number of parallel threads available for processing STIX:

4
a. Goto (Admin) > Services > Context Hub service > View > Explore.
b. In the tree panel, navigate to enrichment/stix/ config.

c. In the right panel, set the stix-query-scheduler-pool-size field value to 2. By default the value is
5. This setting controls how many number of threads are allowed to process queries for STIX
data at the same time.

d. Set the taxii-poll-scheduler-pool-size ficld value to 2. By default the value is 5. This setting
controls how many number of threads are allowed to poll TAXII servers at the same time.

e. Restart the Context Hub server.

Troubleshooting Live Connect Threat Data Sharing
This section discusses troubleshooting Live Connect Threat Data Sharing.

Query Log Retrieval Sample

To retrieve a sample of threat intelligence data sent to Live Connect, you must construct a URL by
setting the following parameters:

¢ sendReport: value is true or false: true to send this report to the Live Connect server. False to
just create the report for viewing. The value defaults to false.

¢ hashValues: value is true or false: true to hash the values as md5/sha256. False to show values in
clear text — should use only for manual viewing. Defaults to false.
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o startDate / endDate: Dates for time boundaries for log entries. Format: YYYY-MM-DD
HH:mm:ss

The following is an example of the URL used to retrieve query logs:

https://<server>/admin/liveconnect/force aggregation?startDate=2016-01-
18%2000:00:00&endDate=2016-01-19%2010:10:00&sendReport=false&hashValues=true

System Logging: Debug

To access debug information:

4
1. Goto (Admin) > System > System Logging.
2. Select the Settings tab.

3. In the Package Configuration section, select com > netwitness > platform > server >
liveconnect > service (DEBUG).

info System Logging
Updates Realtime Historical sertings
Licensing
Ernail Package Configuration
Global Notifications B[ investigation B
Legacy Motifications B[ list
I Systemn Logging B[l

= li ct
Global Auditing Sivaconns

B service (DEBUG)

Jobs
i LiveConnectClient
Live Services i LiveConnectloghegregatorService
URL Integration § LiveConnectLogParserSeruice
Context Menu Actions i LiveConnectlogRetrievalService
. . B[ ] malware -
Investigation N
HTTP Proxy Settings
Package com.rsa.smesaliveconnect.service
NTP Settings Log Level DEBUG ~
Dashboard Settings L] Reset recursively

Apply Reset

2 adrmin | @BEnglish (United States) | GMT+0
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